Panasonic

Operating Instructions

Geometric & Setup Management Software
Geometry Manager Pro Ver. 4.0

Windows

Thank you for purchasing this Panasonic product.

m Before using this software, please read the instructions carefully.
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Precautions and Disclaimers

® Precautions regarding security
When using the “Geometric & Setup Management Software” (Geometry Manager Pro), security breaches of the type
described below are conceivable.

® Leakage of your private information via this software

@ lllegal operation of this software by a malicious third-party

® Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
® Make sure the password is as hard to guess as possible.
® Change the password periodically.
® Panasonic Corporation and its affiliated companies never directly ask customers for their password. Do not give out your
password even if directly asked by a third-party representing themselves as Panasonic Corporation.
® Always use on a network that has safety protection such as a firewall implemented.
® Set the password for the computer you are using in order to set limits on user accessibility.

® This software makes use of the following software.
A portion of this software is based in part on the work of the Independent JPEG Group.

® The illustrations and display examples used in this manual may differ from the actual product.

@ Panasonic cannot be held liable for damages arising from data corruption or loss as a result of using this projector.



What You Can Do with “Geometry Manager Pro”

Using this software allows you to perform real-time geometric compensation and other fine adjustments and corrections that
cannot be handled on the projector side.

Even when you use this software, however, some functions and expanded functions may be limited if projector and computer
activation are not completed.

&= “Activation” (page 12)

&~ “Functions which are expanded as a result of activation” (page 20)

B Geometry correction

When projecting images onto a screen surface that is not perfectly flat (such as the
wall of a building) or projecting them onto a screen surface at an angle, the images
become distorted.

When projecting images in these kinds of special environments, the geometry
correction function serves to correct the images to counter the shape of the screen

SN

> surface.

\i |
-u m Edge blending
’ P This function serves to correct the brightness and makes the joins between the
H images less visible when the images projected from a multiple number of projectors
are combined to form a single image.

B Uniformity

This function makes it possible to correct color irregularities in projected images
— for example, those resulting from irregularities in the screen surface or from
surrounding light and shade.

B Masking

This function makes it possible to mask certain parts of the projected images,
projecting only the required parts.

H Auto Screen Adjustment (AUTO ADJUST)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the
shape of the screen through use of a camera.

® Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” must be
installed to use the Auto Screen Adjustment function.
® To use the Auto Screen Adjustment function, prepare a camera separately. & “Camera connection” (page 88)

H Other functions

The lens, color matching and input signal can all be adjusted.
Some of the projector’s menu operations can also be carried out on a computer screen.



Check Your Computer

System requirements

The computer must meet the following requirements in order to use the supplied software.

OS: Microsoft Windows 7 Ultimate 32/64bit, Professional 32/64bit
Home Premium 32/64bit
Windows 8.1 Windows 8.1 32/64bit, Windows 8.1 Pro 32/64bit
Windows 10 Windows 10 32/64bit, Windows 10 Pro 32/64bit

Compatible with English, Japanese or Chinese language versions of the above operating systems.
» Compatible with Windows 7 up to SP1.
* For a 64bit OS, this application runs on WOWG64.
CPU: Clock speed of 1 GHz or higher
Memory: 2 GB or more
Available disk space:
16 GB or greater (Further available space is necessary to save projector information)
Other requirements:
A display with a resolution of 1 024 x 768 pixel or higher using High Color (16 bit) or higher
LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T)
USB2.0-compatible port or higher (when using the Auto Screen Adjustment function)

® Please understand that operation is not guaranteed if this software application is used in a system environment other than
that specified above or on a home-built computer.

Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected

Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.

Computer with a built-in LAN function
® |Is your LAN switched on?

Computer without a built-in LAN function
® |s your LAN adapter properly recognized?

Please install the LAN adapter driver beforehand.

For details on how to install the driver, please refer to instructions accompanying the LAN adapter.
® |s your LAN adapter switched on?

@® It may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN
adapter are installed.
& “Frequently Asked Questions” (page 113)

® Operation is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.

® An Internet connection is required to perform activation.



Installing/Uninstalling Software

Installation

Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing “Geometric & Setup Management Software” (Geometry Manager Pro)

1 Download the software.

® Download “Geometry Manager Pro”.
Log in to PASS*! on the Panasonic website (https:/panasonic.net/cns/projector/pass/), click [Software Download], and
follow the on-screen instructions to download the software. You must be registered with PASS to log in to it.
*1 PASS: Panasonic Professional Display and Projector Technical Support Website. For details on PASS, refer to the
Panasonic website (https://panasonic.net/cns/projector/pass/).

To enable use of the Auto Screen Adjustment function, download the “Auto Screen Adjustment plug-in software” as well.
&= “Installing the “Auto Screen Adjustment plug-in software” (page 8)

2 The installer starts up.

Double-click the downloaded “Installer.exe” file.

45 Geometry Manager Pro Ver XXX - o

Welcome to the Geometry Manager Pro Ver X.X.X ()
Setup Wizard :

The installer wil guide you through the steps required to install Geometry Manager Pro Ver XXX on
pour computer.

WARNING: This computer program is protected by coppright law and intemnational treaties,
Unauthorized duplication or distribution of this program. or any portion of it. may result in severe civil
or criminal penalties. and will be prosecuted to the maximum extent possible under the law.

Follow the on-screen instructions to install the application.

3 As soon as the installation process is completed, a shortcut icon is created on the desktop.

If an identical version of the software is already installed, the following screen for selecting whether to repair or remove the
existing version appears.



Installing/Uninstalling Software Installation

15 Geometry Manager Pro VerX.X.X — .

Welcome to the Geometry Manager Pro Ver. X.X.X [
Setup Wizard

Select whether you want to repail or remove Geomety Manager ProWer XXX

(®) Repair Geometry Manager Pra Ver XX
(O Remove Geometry Manager Pro Ver X3

Cancel <Back

+ To repair defects in the software, select “Repair Geometry Manager Pro”, and click [Finish].
To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro], and
click [Finish].

+ If you selected [Repair Geometry Manager Pro] and the “Insert disk” message is displayed, uninstall the
application, and then reinstall it.

Installing the “Auto Screen Adjustment plug-in software”

1 Download the “Auto Screen Adjustment plug-in software”.

® Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” are
necessary to use the Auto Screen Adjustment function.
Log in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/), click [Software Download], and
follow the on-screen instructions to download the “Auto Screen Adjustment plug-in software”.

2 The installer starts up.
Double-click the downloaded “Auslinstaller.exe” file, and follow the on-screen instructions to install the application.

The compatible combination of versions for the “Auto Screen Adjustment plug-in software” and the “Geometry Manager
Pro” is predetermined. Therefore, an error message will appear if you attempt to install an incompatible version of the “Auto
Screen Adjustment plug-in software”. In such cases, check whether the version of “Geometry Manager Pro” that appears

in the error message matches the software version found on the above website. If the versions match, download and

install only “Geometry Manager Pro” from the website. If the versions do not match, download and install both “Geometry
Manager Pro” and the “Auto Screen Adjustment plug-in software”.

3 When installation is complete, the [AUTO ADJUST] (Auto Screen Adjustment) button at the top right of the
“Geometry Manager Pro” main screen will be enabled.

- O X

[ @ AuTo ADIUST

ﬂ Culurf.‘atching| Masking| Input Signal| Other |

If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message
indicating that installation of the plug-in software is required will appear.



Installing/Uninstalling Software Software Uninstall

Software Uninstall

Windows 7
Select [Geometry Manager Pro] from [Start] — [Control Panel] — [Uninstall a program], and click [Uninstall].

Windows 8.1 / Windows 10
Press [X] while holding down the [Windows logo] key on the keyboard. Select [Geometry Manager Pro] from [Control Panel] —
[Uninstall a program], and click [Uninstall].

Uninstalling “Geometry Manager Pro” will not uninstall the “Auto Screen Adjustment plug-in software”. Perform the same
procedure as the above to uninstall the “Auto Screen Adjustment plug-in software” (Geometry Manager Pro - Auto Screen
Adjustment plug-in).



Preparation

B Projectors supported

For details on models compatible with “Geometry Manager Pro”, check the information found on the software download page
after logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

No guarantees are made for the operations when the computer is connected to a non-supported projector.

B Projector and computer connections

Connect the projector and computer using a LAN cable.
Up to 99 projectors can be connected.

® Please use a crossing cable to connect the computer and projector when it is directly connected to the LAN.
® When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the system
configuration. Please consult your network administrator for details.

m Setting the Computer

Network Setup
® Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment.
(Please consult your network administrator for details.)
@ If “use of automatic script” is checked for your web browser, please uncheck.
@ If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to
“Exceptions” in the detailed proxy settings.

10



Preparation

B Setting the Projector

Network Setup
Set the IP address, subnet mask, and default gateway according to your operating environment. (Please consult your
network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on
the LAN.
If the entered IP address is used by another device, the projector cannot be registered.

® For models that can be set, enable both WEB Control and Command Control.
® For models in which the Web port number can be set, set the port number to “80”.

® Refer to operating manual of the projector for method on configuring the projector.

® This software identifies the projector using the configured IP address. If DHCP is set to ON in the projector network setting
in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the
projector, making it impossible to connect using this software.
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP
address allocated to the projector. (Please consult your network administrator for details.)

m Activation

There are functions that are enabled and functions that are expanded by performing activation.

The upgrade kit (ET-UK20), Auto Screen Adjustment upgrade kit (ET-CUK10), and Auto Screen Adjustment upgrade kit (PC)
(ET-CUK10P) are required for activation. For details on compatible projector models, check the information found on the
activation page by logging in to PASS on the Panasonic website (https:/panasonic.net/cns/projector/pass/).

&= “Functions which are expanded as a result of activation” (page 20)

The “Auto Screen Adjustment plug-in software” must be installed and the Auto Screen Adjustment upgrade kit (ET-CUK10)
must be applied on the projector or the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) must be applied on the
computer to enable the Auto Screen Adjustment function.

m Camera connection

To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen
Adjustment” (page 88).

11



Activation

There are functions that are enabled and functions that are expanded by performing activation.

There are two methods of activation: one is to apply a kit on the projector to add or expand the functions of the projector
(projector activation) and the other is to apply a kit on the computer to expand the functions of the software installed on that
computer (computer activation).

The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for the former method and

the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) is required for the latter method. For details on compatible
projector models, check the information found on the activation page by logging in to PASS on the Panasonic website (https://
panasonic.net/cns/projector/pass/).

& “Functions which are expanded as a result of activation” (page 20)

Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen
Adjustment function.

Perform the projector activation

The flow of operations from installation to activation is as follows.

This sections describes projector activation.
at

‘Input
Key code B a Activation code

@ad D E ‘
Device D ’ Activation code

information file ACTIVE.LST m - /

5
af:

‘.‘ Export
we * ”'

-

F 3

A

5

wilood

A

Software installation

‘ Device information file
SERIAL.LST

1 Have the key code ready.

The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit
(ET-CUK10).

12



Activation

Perform the projector activation

2 Start the software application, and display the main screen.

&= “Adjustment and Settings — Main screen” (page 24)

3 On the [File] menu, select [Activation] - [Export Equipment Profile] - [ET-UK20/ET-CUK10].

® All the projectors to which the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10) is not
applied will be targets for operation.

@ All connected projectors will be displayed in the common operation area. However, the operation cannot be performed
while two or more of these projectors are selected.

® In the common operation area, an asterisk (*) appears to the left of projector names for which the upgrade kit (ET-UK20)
has not been applied. You can check whether the Auto Screen Adjustment upgrade kit (ET-CUK10) is applied when using
the Auto Screen Adjustment function.

ﬂ Geometry Manager Pro

File Edit View Tools Version

Open File (Current Tab)
Open File (One Projector)
QOpen File (All Projectors)
Open File (Connection Only)

Save File (One Projector)
Save File (One Projector) As...

Save File (All Projectors) As...

Save File (Connection Only) As...

Reset Data (Current Tab)
Reload (Current Tab)

Activation

Export

Exit

| Test Pattern

The file save screen is displayed.

>

>

(o

“ens Sefting Geumetry| Edgeﬂ\ending| Unifurmity‘ Brightness Control | Color Mate

-ens Position Lens Memory

@ 1. LENSMEMORY1

: 2. LENSMEWMORYZ

A 3. LENSMEMORY 3

ddd A4 | - e Rk ML 4 LENSMEMORY4
Export Equipment Profile > ET-UK20/ ET-CUK10

Activate License 3 ET-CUK10P Y5

; 6. LENSMEMORY&

4 Specify the save destination, name the file, and save.
® The default file name is “SERIAL.LST.”

When the confirmation screen for saving the file appears, click [OK].

Geometry Manager Pro x

o Equipment Profile was saved.

5 Start the web browser, and log in to PASS of the Panasonic website (https://panasonic.net/cns/projector/pass/).

6 Click the activation button in the side menu of the top page, and follow the on-screen instructions to perform key

code registration, etc.

Register the key code readied in step 1 and the file (default file name: SERIAL.LST) saved in step 4 to PASS to acquire the
activation code file (default file name: ACTIVE.LST).
® The activation codes for the upgrade kit (ET-UK20) and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be

acquired separately.

7 Close the web browser.

13



Activation Perform the projector activation

8 On the [File] menu, select [Activation] - [Activate License] - [ET-UK20] or [ET-CUK10].
The file selection screen is displayed.

A Geometry Manager Pro

File Edit View Tocls Version

Open File (Current Tab) ||

Open File (One Projector)

Open File (All Projectors) -ens Setting Geometry ‘ Edge Blending | Uniformity ‘ Brightness Control 1
Open File (Connection Only) [ boskion

Save File (One Projector) @

Save File (One Projector) As...
Save File (All Projectors) As... :
Save File (Connection Only) As...

Reset Data (Current Tab) A
Reload (Current Tab)
Activation > Export Equipment Profile >
Export > Activate License > ET-UK20
Exit ET-CUK10
ET-CUK10P
| Test Pattern | ;

9 Select the activation code file (default file name: ACTIVE.LST) acquired in step 6.
When activation is complete and the confirmation screen appears, click [OK].

Geometry Manager Pro >

o Activation has succeeded.

14



Activation Perform the computer activation

Perform the computer activation

This section describes computer activation.

1 Have the key code ready.
The key code is indicated on the key code label of the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P).
Computer

installed the
software

Key code| <+ E‘iﬂ
£anine

2 Start the software application, and display the Connection Setting screen or the main screen.

3 Select [Activation(ET-CUK10P)] - [Export Volume Serial] from the [Option] menu of the Connection Setting screen
or [Activation] - [Export Equipment Profile] - [ET-CUK10P] from the [File] menu of the main screen.

m Geometry Manager Pro x
Option
Activation(ET-CUK10P) >I Export Volume Serial I
Service Password Activate Software License
Version
P Address | 192 . 168 . 0 . 9

m Geometry Manager Pro
File | Edit View Tocls Version

Open File (Current Tab O

Open File (One Projector)

Open File (All Projectors) ens Seting Geometry | Edge Blending | Uniformiy | Brightness Control | Color Na

Open File (Connection Cnly) LTSI Lens Memory

Save File (One Projector) @ 1. LENSMEMORY1

Save File (One Projector) As...

Save File (All Projectors) As... : 2. LENSMEMORYZ
Save File (Connection Only) As.
A 3. LENSMEMORY 3
Reset Data [Current Tab)
Reload [Current Tab)
ddd  dd @ _a o Rk kR 4. LENSMEMORY 4
Activation > Export Equipment Profile > ET-UK20 /7 ET-CUK10
Export ¥ Activate License >I ET-CUK10P
Exit
6. LENSMEMORYS
| 08N 0N NSn OFF !

The [Input Key Code] screen appears.

4 In the [Input Key Code] screen, enter the key code indicated on the key code label.

The key code consists of 25 single-byte alphanumeric characters. All letters should be uppercase, and 5 characters
should be entered in each box.

Input Key Code X

oK Cancel

Your Volume Serial Number

*Log in the PASS(Refer to the instruction manual for URL) web site, and visit “activation™ page.
*Then follow the procedures, upload the exported Yolume Serial Mumber
* (SERTAL.LST) file OR enter your Volume Serial Number manually on to PASS.

Click [OK] to display the file save screen.

15



Activation

Perform the computer activation

5 Save the Volume Serial file ("SERIAL.LST") to any location.

Key code

-

.

Volume serial file )

or
Volume serial number

DXXXXX-XXXKX-x X

J

You can change the file name as desired, but do not change the extension (.LST). To return to the [Input Key Code]
screen, click [Cancel] in the file save screen. When saving of the file is completed, the [Input Key Code] screen closes.
Once the file has been saved, the volume serial number (20 single-byte alphanumeric characters) appears in the [Input

Key Code] screen.

If you will enter this volume serial number manually to download an activation code file later in this procedure, write down
this code and take care not to lose it before activation is completed.

Input Key Code

Your Volume Serial Number

[15360 | -[eazse |-[ocsas | -[ssver |

*Log in the PASS{Refer to the instruction manual for URL) web site, and visit “activation™ page.
*Then follow the procedures, upload the exported Volume Serial Number
* (SERIAL.LST) file OR enter your Volume Serial Number manually on to PASS.

OK

6 Start the web browser, log in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/), and
click the [Activation] button from the side menu of the member top page.

7 Follow the on-screen instructions to download the activation code file.

Download the activation code file ("ACTIVE.LST") using one of the following two methods.

4 A

Volume serial file

or

R

(" Activation code file )

Volume serial number

DO XXXXX =X XX
\§ J

Key code

16

> or

Activation code

PORXXI=DRXOXX=DXXKX-KXX -
\ J




Activation Perform the computer activation

When using a volume serial file (default file name: SERIAL.LST)

Follow the on-screen instructions to upload the volume serial file to PASS, enter the key code, and download the activation

code file ("ACTIVE.LST") to any location.

® You can change the activation code file name as desired, but do not change the extension (.LST).

® The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file ("ACTIVE.LST") to perform activation later in this procedure. If you
will enter the activation code manually to perform activation, write down this code and take care not to lose it before
activation is completed.

When entering the volume serial number manually

Follow the on-screen instructions to register the volume serial number to PASS, enter the key code, and download the

activation code file ("ACTIVE.LST") to any location.

® The volume serial number consists of 20 single-byte alphanumeric characters. All letters should be uppercase, and 5
characters should be entered in each box.

® You can change the activation code file name as desired, but do not change the extension (.LST).

® The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file to perform activation later in this procedure. If you will enter the
activation code manually to perform activation, write down this code and take care not to lose it before activation is
completed.

8 Close the web browser.

9 Perform activation.

Perform activation using one of the following two methods.

(" Activation code file )

or
Activation code

= XKD DX XXX
\ J

When using the activation code file (default file name: ACTIVE.LST)

1) Select [Activation(ET-CUK10P)] - [Activate Software License] from the [Option] menu of the Connection Setting screen
or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen and then click the [By import
"Activation Code" file] button.

m Geometry Manager Pro *
Opticn
Activation(ET-CUK10P) » Export Volume Serial
Service Password I Activate Software License I
Version
P Address | 192 188 . 0 . 9

17



Activation Perform the computer activation

u Geometry Manager Pro
File Edit View Tools Wersion

Open File (Current Tab) (]

Open File (One Projector)
Open File (All Projectors) -ens Setting Geometry ‘ Edge Blending | Uniformity ‘ Brightness Cont

Open File (Connection Only) LTS Lens

Save File (One Projector) @ 1. LEN

Save File (One Projector) As...
Save File (All Projectors) As... : ELLER
Save File (Connection Only) As...

3. LEN
Reset Data (Current Tab) A
Reload (Current Tab)
Add Ad —d | » » 4. LEN
Activation > Export Equipment Profile >
Export > Activate License > ET-UK20 1
=
ET-CUK10P
OSDON 0SD OFF !
Activation x

How you input Activation Code into the program?

: By impol ctivation Code” file

By entering "Activation Code™

2) Select the activation code file (default file name: ACTIVE.LST) downloaded from PASS.

When entering the activation code manually

1) Select [Activation(ET-CUK10P)] - [Activate Software License] from the [Option] menu of the Connection Setting screen
or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen and then click the [By
entering "Activation Code"] button.

[ Geometry Manager Pro X
Option
Activation(ET-CUK10P} > Export Volume Serial
Service Password I Activate Software License I
Version
P Address [ 192188 . 0 . @

u Geometry Manager Pro
File Edit View Tools Version

Open File (Current Tab) |

Open File (One Projector)
Open File (All Projectors) -ens Setting Geometry ‘ Edge Blending | Uniformity ‘ Brightness Cont

Open File (Connection Only) -ens Position Lens.
Save File (One Projector) @ 1.LEN
Save File (One Projector] As...

Save File (All Projectors) As.. 4 2 LEN
Save File (Connection Only) As...

3.LEN
Reset Data (Current Tab) A
Reload (Current Tab)
ddd || dd - [ » » 4 LEN
Activation > Export Equipment Profile >
Export > Activate License 3 ET-UK20 1
Exit ET-CUK10
OSD ON 0SD OFF !
Activation X

How you input Activation Code into the program?

By import "Activation Code” file

E By entering "Activation Code™ il
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Activation Perform the computer activation

2) After downloading the activation code file, enter the last 13 characters of the displayed activation code.
® The activation code consists of 30 single-byte alphanumeric characters. All letters should be uppercase, and 3
characters should be entered in the first box and 5 characters should be entered in each of the remaining boxes for
the last 13 characters.

Entering "Activation Code” manually X
Refer PASS neb site and enter the last 13 alphanumeric of the Activation
| so000¢ | -[ 00000 | - | 000 | - Ell - E I
Cancel

1 0 When activation is completed, the activation code is registered to the computer.

When the confirmation screen appears, click [OK].

® |f activation failed, check the following again.
- The key code input in the [Input Key Code] screen in step 4 and the key code input when uploading the volume serial
file (default file name: SERIAL.LST) to PASS or registering the volume serial number to PASS are different.
- The volume serial file or the volume serial number created in step 5 and the volume serial file uploaded to PASS when
generating the activation code or the volume serial number entered when registering to PASS are different.
® \When computer activation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as
shown below.

— O x — m] pad
I FFEEEET) i@ AuTo ADJUST I [ 1@ AuTo ADIusT L
Before activation After activation
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Activation Functions which are expanded as a result of activation

Functions which are expanded as a result of activation

Listed below are the functions which are expanded when the activation process has been completed.

m Upgrade kit (ET-UK20)

Function Activation not completed Activation completed
When the resolution of the projector
is 1920 x 1200 dots or 3840 x 2400 2x2 to 11x11 2x2 to 41x26
Grid pattern dots
:’:'}i’; ;::orse; z:’ttsw" of the projector 2x2 to 11x11 2x2 to 2922
corestion. w0 45
Adjustment | Horont! keystone 115 140"
Geometry ranges Vertical arcs 150 +100
Correction Horizontal arcs 150 +100
Pincushion 150 +100
Rotational correction - \
Flip Vertical 3 J
Flip Horizontal
Flexible Correction - v
Uniformity Flip Vertical _ N
Flip Horizontal
Masking - N

\': Can be used.
—: Cannot be used.

B Auto Screen Adjustment upgrade kit (ET-CUK10) / Auto Screen Adjustment upgrade kit
(PC) (ET-CUK10P)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape
of the screen through use of a camera.

® Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen
Adjustment function.
@ To use the Auto Screen Adjustment function, prepare a camera separately. &= “Camera connection” (page 88)
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Starting and Exiting the Application

Double-click the shortcut icon on the desktop.
When the application starts, the connection settings screen appears.

n Geometry Manager Pro X

QOption
Connection Setting

® LAN

[Jnd i Addrasss S LAN connection

() Load from file

File connection

File path Selec

Exit

Select [ @) LAN ] to use a LAN connection for the projector and computer, and select [ /@ Load from file ] to connect
by loading a saved file.

The following items can be selected from the [Option] menu at the top left of the connection settings screen.
Activation (ET-CUK10P)
This performs Auto Screen Adjustment upgrade kit (PC) activation.
Export Volume Serial
This creates a volume serial file (file registered to PASS).
This file is required to acquire the activation code file.
&= “Activation” (page 12)
Activation Software License
This performs computer activation. An activation code file or activation code is required.
&= “Activation” (page 12)
Service Password
This menu is used to support maintenance by Panasonic. It is not normally used.
Version
This is where the application’s version information can be checked.
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Starting and Exiting the Application Starting the application

H LAN connection
Select [ @l LAN ] and configure the following settings.

IP Address
Input the IP address of the projector to be connected to the computer. When searching for a connected projector, enter
an IP address to start searching.

End IP Address
When searching for a connected projector, select the check box and enter an IP address to end searching.

® Specify the same network address for the IP Address and End IP Address.
® [f the search range is too wide, an error will occur when you start the search.

Port

Set the number of port on the computer for connecting with the projector.
User Name

Input the user name used for WEB control of the connected projector.
Password

Input the password used for WEB control of the connected projector.

When not searching for a connected projector, click [Connect] after configuring the settings to display the main screen.
& “Adjustment and Settings — Main screen” (page 24)

When searching for a connected projector, click [Search] after configuring the settings to start the search according to the
settings. The projector search screen is displayed while the search is in progress.

Geometry Manager Pro >
e Cancel
_Available projectors: 2 Selected: 2 Upper limits: 99 Cancel the search.
IP Address Model MName Status When a search is canceled, projectors that have
132.158.0.3 PT-DZ780 MNAMES5051 been detected up to that point will be displayed.
192.168.0.10 PT-RZETO NAMED203
I Connected projector list
Displays a list of projectors that were detected via
the search.
Connect
Connect to the selected projectors, and display
£ > . . .
the main screen. & "Adjustment and Settings —
i II Cear | lﬂ Main screen" (page 24)

Clear All
Clear selection of all detected projectors.

Select All
Select all detected projectors.

When [Exit] is clicked, the application is exited without establishing a connection.
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Starting and Exiting the Application Starting the application

H File connection

Select[ @ Lipad from file 1and configure the following settings.

File path
Specify a file (with .prjc or .prjs extension) saved in the past.
Click [Select] to open the file selection screen.

After performing the settings, click [Connect] to display the main screen. &= “Adjustment and Settings — Main screen” (page 24)
When [Exit] is clicked, the application is exited without establishing a connection.

The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied.

Geometry Manager Pro X

This projector has limitation on the following functions.
- Geometry
- Uniformity
- Masking

Please check the following:

- Does the prejector support the upgrade kit?
- Is the projector activated using the upgrade kit?

Exiting the application

To exit the connection main screen, either select [File] and then [EXxit] or click the button at the top right of the window.
To exit the connection settings screen, either click the [Exit] button or click the button at the top right of the window.
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Adjustment and Settings
 Mainscreen

The main screen consists of the following five general areas and the AUTO ADJUST (Auto Screen Adjustment) button.

Main menu Adjustment area AUTO ADJUST (Auto Screen
Adjustment) button

| Geometry Manager Pro —

o x

File Edit Wiew Tools Version

Icon menu—{= & & = I | I[mﬁ]AUTOADJUST—

Lens Setting || Geomelry  Edge Blending | Uniformity | Brightness Contrel | Color Matching | Masking | Input Signal | Gther

03 PROJECTOR3 (0.0.0.3)
04 PROJECTORA4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
[} PROJECTORS (0.0.0.6)
o7 PROJECTORT (0.0.0.7)
08 PROJECTORS (0.0.0.8)

Rename

Display Projector Name

Power ON Standby

Shutter Close Shutter Open
Common operation area — OGSO OS0.0CH
Status ON Status OFF
Status Page Prev Next
Test Pattern

OFF ~

Grid Resolution
11 vox N ~

[ use Square Grid
Display Grid Lines
OFF ~

Cursor Information
Display Cursor

Coordinate Information @ e

[g] None Moving Area
O Absolute

O oFF v 0 | [ |Smoothing | Alert Distortion b4
) Relative

Free Grid

AAAQNe

Transfer

[] Auto Transfer

w174

Status bar

® When using this application, keep the main power of the projector in the “on” setting.
If the standby mode is set to [Normal], the [Power ON] operation is enabled even when the projector is in standby mode.
However, if the standby mode is set to [ECQ], all operations including [Power ON] will be disabled. When using this
application and performing the [Power ON] operation, set the projector’s standby mode to [Normal]. Operations other than
[Power ON] are not guaranteed, when the standby mode is set to [Normal].

® If the projector settings have been changed using a remote control, for instance, rather than the software application, the
software application displays and projector settings may not match.

Adjustment area

You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The modes in which these adjustments and operations are performed are called “editing modes.”
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Adjustment and Settings Main screen

Main menu

H File submenu

Open File (Current Tab)
This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the
computer.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Open File (One Projector)
This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected
projector.
When this menu item is selected, the loaded settings are reflected in the target projector even if ("] Auto Transfer (at the
bottom of the common operation area) has not been checked.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as
the one when the setting file was saved.
Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target projectors that are connected even if

("] Auto Transfer (at the bottom of the common operation area) is not checked.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

When the file is loaded, an error message is displayed if the target projector is not connected to the network. When the
connection of the target projector to the network is recognized, the connection is established and the loaded settings
are reflected automatically.

Open File (Connection Only)
This loads a setting file (with .prjc or .prjs extension) saved to the computer and reflects the status of the connection
with the saved projector.

® When the file is loaded, an error message will be displayed if the target projector is not connected to the network, but
a connection will be established automatically when the computer recognizes that the target projector is connected
to the network.

® Even if a setting file (with .prjs extension) is selected, the settings of the projector target for connection are not
reflected.

Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.

Save File (One Projector) As...
This saves the settings now being edited in a file under the filename (with .prj extension) provided.

Save File (All Projectors) As...
This saves the setting information of all the currently connected projectors as a single All Project File (with .prjs
extension) on the computer.
The layout information, IP addresses, user names, and passwords of the projectors are also encrypted and saved in the
All Project File.
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Adjustment and Settings Main screen

Save File (Connection Only) As...
This saves the connection information of all the currently connected projectors as a single file (with .prjc extension) on
the computer.
The IP addresses, user names, and passwords of the projectors are also encrypted and saved.

Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Reload (Current Tab)
This cancels the settings currently being edited using the application, and loads the same settings again from the
projector.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Activation
Export Equipment Profile (ET-UK20 / ET-CUK10 / ET-CUK10P)
Creates a file to be registered in PASS. This file is required to acquire the activation code file.
& “Activation” (page 12)

Activate License (ET-UK20 / ET-CUK10 / ET-CUK10P)

Select [ET-UK20], [ET-CUK10], or [ET-CUK10P] and then perform activation.

&= “Functions which are expanded as a result of activation” (page 20)

® The activation code file is required.
& “Activation” (page 12)

® If the “Auto Screen Adjustment plug-in software” is not installed, [ET-CUK10] or [ET-CUK10P] cannot be selected.
&= “Installing the “Auto Screen Adjustment plug-in software™ (page 8)

Export
Multi Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Monitoring & Control Software”.
The file is for registering the data of the projectors already registered in the software application in the “Multi Monitoring
& Control Software” for monitoring and control purposes.
For details, refer to the operation manual of the “Multi Monitoring & Control Software”.
Exit
Exits the software.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
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Adjustment and Settings Main screen

m Edit submenu

Undo
This discards the software application and projector settings currently being edited.
It returns these settings to the status before the setting data is sent.

Redo
This returns the settings to the ones before the Undo operation is performed.

@ Undo and Redo can be used up to 50 times during a single setting process (for each editing mode).
® The Undo and Redo logs are cleared if you switch to another editing mode or projector.

The following Edit submenu items are enabled only in certain editing modes. For details, refer to the respective reference
pages.
Lock

& “Adjustment and Settings - Geometry Correction” (page 41)

Unlock
& “Adjustment and Settings - Geometry Correction” (page 41)

Free
& “Adjustment and Settings - Geometry Correction” (page 41)

Reset
& “Adjustment and Settings - Geometry Correction” (page 41), “Adjustment and Settings — Uniformity” (page 60),
“Adjustment and Settings - Masking” (page 69)

Flip Vertical
&= “Adjustment and Settings — Geometry Correction” (page 41), “Adjustment and Settings — Uniformity” (page 60),
“Adjustment and Settings - Masking” (page 69)

Flip Horizontal
& “Adjustment and Settings - Geometry Correction” (page 41), “Adjustment and Settings — Uniformity” (page 60),
“Adjustment and Settings - Masking” (page 69)

Area Select
& “Adjustment and Settings — Uniformity” (page 60)

Point Select
&= “Adjustment and Settings — Uniformity” (page 60)
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Adjustment and Settings Main screen

H View submenu

Tool Bar, Status Bar, Sub Window, Layout Window
Enter a check mark, and select whether the items are to be displayed.
In the initial status, “Tool Bar” and “Status Bar” are displayed.

Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the
projector as soon as they are changed.

® Entering a check mark causes a check mark to appear in ("] Auto Transfer in the lower left of the common operation
area.

Line Color
White / Red / Green / Blue
These perform the same operations as the icon menu [White], [Red], [Green] and [Blue] on the Geometry screen.
&= “Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)

Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.
& “Adjustment and Settings - Main screen - Coordinate Information” (page 35)

Grid Resolution
Use Square Grid / X /Y
These select the mode in which the coordinates of the control points are displayed.
&= “Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)

Zoom
x1/8 1 x1/14 1 x1/2 1/ x1/x2/x3/x4/x5/x6/x7/x8
The editing area is zoomed in or out.

Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.
&= “Adjustment and Settings - Masking - Masking screen” (page 69)

H Tools submenu

Command Control
This displays the Command Control screen.
& “Projector Control” (page 86)
Auto Screen Adjustment
This displays the Auto Screen Adjustment screen.
This performs the same operation as the [AUTO ADJUST[ (Auto Screen Adjustment) button.
&= “AUTO ADJUST (Auto Screen Adjustment) button” (page 36)

This cannot be selected if the “Auto Screen Adjustment plug-in software” is not installed.

B Version submenu

About Geometry...
This displays version information for “Geometry Manager Pro”.
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Adjustment and Settings

Main screen

Icon menu

This icon menu is used in all the editing modes.

For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.

|
ka= Open File (One Projector)

This performs the same operation as [Open File (One Projector)] on the File submenu.

E Save File (One Projector)

This performs the same operation as [Save File (One Projector)] on the File submenu.

6 Reload (Current Tab)

This performs the same operation as [Reload (Current Tab)] on the File submenu.

ﬂ: Undo

This performs the same operation as [Undo] on the Edit submenu.

ct? Redo

This performs the same operation as [Redo] on the Edit submenu.

Layout Window
Each time this is clicked, the Layout Window screen is switched between displayed and cleared.
On the Layout Window, the positions of the projectors can be changed by means of mouse operations.

When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved.

Main screen operations can be performed even while the Layout Window is displayed.
The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu.
The Layout Window screen below is an example when eight projectors are connected.

Layout Window n
Selection area
The projector layout is displayed.
| m || 0z || 03 || 04 | You can change the active projector by clicking one of the rectangles
| s ” 0 ” 0 ” 08 | representing the projectors.

The frame of the selected projector is indicated in red.

I oK " Cancel " Apply I

Apply
Click to apply the layout displayed in the selection area.
The screen is not closed.

Cancel

selection area.
OK

Click to close the screen without applying the layout displayed in the

Click to apply the layout displayed in the selection area and close the

screen.

|_] Reset Data (Current Tab)

This performs the same operation as [Reset Data (Current Tab)] on the File submenu.

L2 Open File (Current Tab)

This performs the same operation as [Open File (Current Tab)] on the File submenu.
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Adjustment and Settings

Main screen

Common operation area

The common operation area houses the operations which can be used in all the editing modes.

Projector list

This list displays the projector numbers, projector names and IP addresses in the
sequence in which the projectors were connected.

The projector currently selected is the one whose data is being edited. Any projector on
the list can be selected to switch the projector whose data is to be edited.

® Multiple projectors can be selected as targets for operations by holding the Ctrl key
while clicking. In that case, the following functions can be operated.
Power ON/Standby, Shutter Close/Shutter Open, OSD ON/OSD OFF, Status ON/
Status OFF, Status Page, Test Pattern, Display Projector Name, Grid Resolution,
Display Grid Lines

® When a projector for which the upgrade kit (ET-UK20) has not been applied is
connected, an asterisk (*) appears to the left of that projector name. An error
message will appear if you connect to this projector and attempt to use the extended

& ¥ -
[} PROJECTOR1 (0.0.0.1)
0z PROJECTORZ (0.0.0.2)
03 PROJECTOR3 (0.0.0.3)
04 PROJECTORA (0.0.0.4)
05 PROJECTORS (0.0.0.5)
0§ PROJECTORS (0.0.0.6)
o7 PROJECTORT (0.0.0.7)
08 PROJECTORE (0.0.0.8)
Del Rename
Display PrDLdur Name
Power ON Standby
Shutter Close Shutter Open
0SD ON 0SsD OFF
Status ON Status OFF
Status Pagy Prev MNext

Test Pattern

OFF

functions. &= “Activation” (page 12)

® When a projector on the list is selected and then double-clicked, the WEB control
screen opens. For details on the WEB control screen, refer to the operating
instructions of the projector.

® When the mouse pointer is placed over a projector on the list, a tooltip appears and
shows the model number and resolution of that projector.

— i | ¥

These change the order of the projectors in the list.

Select a projector in the list and then click the up arrow button to move it up one place in

the list or click the down arrow button to move it down one place in the list.

@ Multiple projectors cannot be moved at the same time.

® When the up arrow button is clicked while the very top projector is selected or when
the down arrow button is clicked while the very bottom projector is selected, the
projector does not move.

® The results of moving the projectors are reflected in Layout Window.
&= "Layout Window" (page 29)

Del

Click to remove the selected projector from the operating targets.
When all the projectors are removed, the software is exited.
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Adjustment and Settings

Main screen

+ &
01  PROJECTOR1 (0.0.0.1)
02  PROJECTORZ (0.0.0.2)
03  PROJECTOR3 (0.0.0.3)
04  PROJECTORS (0.0.0.4)
05  PROJECTORS (0.0.0.5)
06  PROJECTORS (0.0.0.6)
07  PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8)
Add Del Rename Rename
Display Projector Name Click to change the name of the currently selected projector.
pdwer on Standby A name can consist of a m?X|mum of 12 characters including letters (upper-case),
numbers, hyphens and periods.
Shitter Close Shutter Open
§sD ON O=C OEE Display Projector Name
Sfatus ON Status OFF Click to display the name and number of the currently selected projector on the image
Status Page | Prev Next projected by the projector.
Test Rattern
OFF Add
Click to display the LAN connection destination selection screen and add a new
projector.

&= “Adjustment and Settings — Main screen — LAN connection destination selection
screen” (page 32)
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Adjustment and Settings Main screen

LAN connection destination selection screen

When is clicked, the LAN connection destination selection screen is displayed.
A projector that is going to be connected now be set.

IP Address
Input here the IP address of the projector to be connected.
To search for a connected projector, enter an IP address to start searching.

—End IP Address
To search for a connected projector, select the check box and enter an IP
address to end searching.

m Geometry Manager Pro X
Lan Note|
- | 192 188 . 0 . B | ® Specify the same network address for the IP Address and End IP

Address.

|192.1es. 0 8 |
! @ |If the search range is too wide, an error will occur when you start the

HiE toz4 search.

User Name: |

—Port
Password:
| 1_ Set here the number of the port that is to be connected to the projector.

| Connect | Exit = User Name

Input here the user name of the projector to be connected.

Password
Input here the password of the projector to be connected.

Exit
Click to cancel the connection with the projector and close the LAN
connection destination selection screen.

Connect / Search

When not searching for a connected projector, connection to the projector
will be established according to the entered settings.

When searching for a connected projector, the projector search will start
according to the entered settings.

A status screen is displayed while the search is in progress. &= "Starting
and Exiting the Application — Projetor Search Screen" (page 22)

When the projector is connected successfully, the LAN connection
destination selection screen is closed.
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Adjustment and Settings

Main screen

T ¥

o1 PROJECTOR1 (0.0.0.1)
02 PROJECTORZ (0.0.0.2)
03 PROJECTOR3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
0§ PROJECTORS (0.0.0.8)
o7 PROJECTORT (0.0.0.7)
08 PROJECTORE (0.0.0.8)

Add Del Rename

Display Projector Name
Power ON Standby

Power ON/Standby
Click the left button to set the power of the selected projector to the “On” state or click the
right button to set it to the standby state.

___The setting is reflected in the projector even when a check mark has not been entered in

("] Auto Transfer.

When the projector is in the standby state, no guarantees are made for any operations
except [Power ON].

— Shutter Close/Shutter Open
Click the left button to set the shutter of the selected projector to the “On” state or click
the right button to set it to the “Off” state.
The setting is reflected in the projector even when a check mark has not been entered in

("] Auto Transfer.

OSD ON/OSD OFF

Click these to select to display (ON) or not display (OFF) the OSD menu on the images
of the selected projector.

This operation is reflected in the projector even if a check mark has not been entered

| Shutter Close Shutter Open I—

0SD ON 0SD OFF
Status ON Status OFF

for [ Auto Transfer.

Status ON/Status OFF

Status Page Prewv
Test Pattern

OFF

Grid Resolution

11 v X |1

Next

Click these to select to display (ON) or not display (OFF) the status (information) on the
images of the selected projector.

The setting is reflected in the projector even when a check mark has not been entered in
("] Auto Transfer.

[Juse Square Grid — Status Page
Display Grid Lines Click these to select the previous or next page of the status screen when the status is
OFF ™ displayed on the projector’s image.

Cursor Infermation
Dizplay Cursor
Coordinate Infermation

None

The setting is reflected in the projector even when a check mark has not been entered in
("] Auto Transfer.

— Test Pattern
Click to switch the image projected from the projector to the test pattern.

Absolute
S — Any of the following test patterns can be selected.
Transfer OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow, Window, Window

Manual Transfer

|:| Auto Transfer

(Inversion), Colorbars (Vertical), Colorbars (Horizontal), 16:9 / 4:3, Crosshatch
(White), Crosshatch (Red), Crosshatch (Green), Crosshatch (Blue), Crosshatch
(Cyan), Crosshatch (Magenta), Crosshatch (Yellow)

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in
("] Auto Transfer.
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Adjustment and Settings

Main screen

Test Pattern

OFF

* &
01 PROJECTOR1 (0.0.0.1)
0z PROJECTORZ (0.0.0.2)
03 PROJECTOR3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
0s PROJECTORS (0.0.0.5)
06 PROJECTORS (0.0.0.8)
i PROJECTORT (0.0.0.7})
08 PROJECTORS (0.0.0.8)
Add Del Rename
Display Projector Name
Power ON Standby
Shutter Clozse Shutter Open
0sD ON 0sD OFF
Status ON Status OFF
Status Page Prev Next

Grid F‘.est'util:ln
" ~| X |1

—n Use Square Grid
Display Grid Lines
OFF

Cursor Infermation
Dizplay Cursor
Coordinate Information

None
Absolute

Relative
Transfer

WManual Transfer

[] Auto Transfer

When a check mark is entered for || Use Square Grid , the two grid resolutions

(horizontal and vertical) become one, and the button for selecting the combination of the

number of grids whose horizontal and vertical intervals are identical is selected.
Any of the following numbers of square grids can be selected.

When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
41x26*, 33x21*, 25%16*, 17x11*, 9%6

When the resolution of the projector is 1400 x 1050 dots:
29x22*, 21x16*, 9%7, 5x4

* Selectable if the upgrade kit (ET-UK20) has been applied to the projector.
&= “Activation” (page 12)

Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

_I—Grid Resolution (vertical)

4" eom—

The number of grids in the vertical direction is selected here.
Any of the numbers of grids listed below can be selected.

When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
Horizontal: 2 to 41*' (2 ~ 11)*2 (default value: 11)
Vertical: 2 to 26*' (2 ~ 11)*2 (default value: 11)

When the resolution of the projector is 1400 x 1050 dots:
Horizontal: 2 to 29*" (2 ~ 11)*2 (default value: 11)
Vertical: 2 to 22*' (2 ~ 11)*2 (default value: 11)

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected

projector.

*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected

projector.
&= “Activation” (page 12)

— Display Grid Lines

The color of the grids to be projected is selected here.

OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow

Default value: OFF

The setting is reflected in the projector even when a check mark has not been entered in

(] Auto Transfer,
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Main screen

01 PROJECTOR1 (0.0.0.1)
02 PROJECTORZ (0.0.0.2)
03 PROJECTORS (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
05 PROJECTORS (0.0.0.6)
o7 PROJECTORTY (0.0.0.7)
08 PROJECTORS (0.0.0.8)

Add Del Rename

Display Projector Name

Power ON Standby

Shutter Close Shutter Open

0SD ON 0SD OFF
Status ON Status OFF
Status Page Prev MNext
Test Pattern

OFF v

Grid Resolution
i el X (11 L

|:| Use Square Grid
Display Grid Lines
OFF e

Cursar Information

— Cursor Information

When a check mark is entered for [~]Display Cursoi, the cursor indicating the position of the
control point can be displayed on the projected image.

The cursor appears only at the top left when the control point has been selected using a
line or area.

If a multiple number of control points have been selected, the cursor will be displayed
only at the control point selected last.

Cursor

Dizplay Cursor

Coordinate Information
None
Absolute

Relative

Transfer
Manual Transfer

|:| Auto Transfer

Coordinate Information
The mode in which to display the control point coordinates is selected here when grids
have been set in one of the editing modes.

None: The coordinates are not displayed.

Absolute: The coordinates with the top left control point used as the origin point are
displayed alongside the control points.

Relative: The coordinates with the initial position of the control point in the selected
grid used as the origin point are displayed alongside the control points.

However, if the grid intervals are narrow, the coordinates may not be displayed even
when Absolute or Relative has been selected.

— Manual Transfer
When this button is clicked, the edited settings are reflected in the projector.

— \When a check mark is entered in || Auto Transfer , as soon as a setting is changed, that

setting is reflected in the projector.
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AUTO ADJUST (Auto Screen Adjustment) button

This allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the
screen through use of an externally connected camera.

Click the [AUTO ADJUST] button to display the Auto Screen Adjustment screen.

& “Auto Screen Adjustment” (page 88)

If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message
indicating that installation of the plug-in software is required will appear.

&= “Installing the “Auto Screen Adjustment plug-in software™ (page 8)

Status bar

This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.

36



Adjustment and Settings

Lens Settings

Lens Settings

Lens setting screen

The lens settings are selected on this screen.

@6 006 @0

@

@ a @ @ @ ® ®» ®
B Geometry Manager Pre O x
File Edit View Tocls Version
Z 8 6 =] (] T @ AvioAanus) B
T & Lens Setting  Geometry | Ed ’Blendmgl Uni rlmty‘ Brighingss Control Cu\DrMalcmng‘ |.|askmg| Input Signalf| Other
01 PROJECTORI (0.0.01) 1 ens Posif | ens Memary
02  PROJECTORZ (0.0.0.2) [LE"S Type ET-D7SLE20 v ]— @
03 PROJECTOR3(0.0.0.3) 1. LENSMEMORY 1 Rename | Load save | Dekete | ons Infarmafion Sefing
04 PROIFCTORL (V00 &) p— n - _@
05 PROJECTORS (0.0.0.5) 2. LENSMEMORYZ2 Rename Load Save Delete
06 PROJLCTORG (0.0.0.6) Lens Name LCNSO01 Rename | [— Z
o7 PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8) A RS hoe Rename Load Save Delgte Ctigs Focus Ootimizar
= = — Active Focus OFF v —@
— — 4 IFNSMFMORY4. Renams Losd Save Dalste =
Display Projector Name < > Focus Offset Bright 00 = @
—
Power ON Standoy v 5. LENSMEMORYS. Rename Jl Load save M Dekete Dark =
Shutter Close Shutter Open Test Patiem OFF v —@
6. LENSMEMURY6E Rename Load Save Delste
030 ON 030 orr l Inmalize —@
Huie Pusilion
Sl STLHAEF [7. LENSMEMORYT T Mzt e Delete
Status Page Prev Mext (& =T
lest Fartern
Viatical Pusilion 0 =11 Aoy . LENSWEMORY3 Rename Jl 16ad cave  neiete
OFF v =
° S| Ay
Grid Resalution — 9. LENSMEMORYS. Rename Load Save Delste
L | > LS i Lens Focus
T T —— Neae 10. LENSMEMORY 10 Rename Load Save Delete
Display Grid Lines
Cursor Information
Lens k [ A
v/ Niplay Cursar il = il
Coordinate Information e
sletsl
Hone Tele Wide
Tt
Transfer
{ Lens Zoom
Manual Transter
[] Auto Transfer
x1/8
Upward

Use this to move the projected image upward.
When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the amount of movement increases progressively for each button in the following order; ﬁ ) E ) |£

Leftward

Use this to move the projected image toward the left.
When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the amount of movement increases progressively for each button in the following order; ﬂ , ﬂ , ﬂ

Rightward

Use this to move the projected image toward the right.
When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order; > , W , .
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@

©

Downward

Use this to move the projected image downward.

When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the amount of movement increases progressively for each button in the following order; T , 3 , i‘.

Vertical Position

Specify the vertical position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Horizontal Position

Specify the horizontal position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Home Position
Click to move the lens position to the home position.

Lens Calibration
Click to automatically set the limit to which the lens is to be moved and the home position of the lens.

Lens Focus (Far)

Click these buttons to adjust the focus to “far”.

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the further toward the left the button is located, the further the focus will move.

Lens Focus (Near)

Click these buttons to adjust the focus to “near”.

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the further toward the right the button is located, the closer the focus will move.

Lens Focus

Specify the focus position as a numerical value.

Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Lens Zoom (Tele)

Click these buttons to reduce the size of the projected image (zoom out).

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the image is reduced in progressively larger steps by clicking the buttons progressively further toward the
left.

Lens Zoom (Wide)

Click these buttons to enlarge the size of the projected image (zoom in).

When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the image is enlarged in progressively larger steps by clicking the buttons progressively further toward the
right.

Lens Zoom

Specify the zoom position as a numerical value.

Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.
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®

Lens Memory Save

Click these buttons to save the focus position, shift position and zoom position of the adjusted lens in the projector's lens
memory.

The number of lens memories available for saving lens settings varies according to model.

Even if a check mark has not been entered for || Auto Transfer | the settings are saved in the lens memory when the
[Save] button is clicked.

This function can be used only for projectors that have this function.

Lens Memory Load

Click these buttons to select and load the lens memory whose settings are saved in the projector.

The lens will move automatically to the saved focus position, zoom position and shift position.

Even if a check mark has not been entered for || Auto Transfer | the settings are loaded from the lens memory when the
[Load] button is clicked.

This function can be used only for projectors that have this function.

Lens Memory Rename
Click these buttons to rename the lens memory settings.
When one of the buttons is clicked, the [Rename] screen is displayed.

Rename X

New Name

LENSMEMORYZ

When a new name is input and the [OK] button is clicked, the [Rename] screen is closed, and the name of the projector’s
lens memory settings is changed.

A name can consist of a maximum of 16 characters including letters, numbers, hyphens and periods.

If the [Cancel] button is pressed instead, the [Rename] screen is closed without renaming the lens memory settings.
This function can be used only for projectors that have this function.

Lens Memory Delete

Click these buttons to delete the settings saved in the lens memory of the projector.

Even if |_| Auto Transfer Transfer is not checked, the settings are deleted from the lens memory when the [Delete] button
is clicked.

This function can be used only for projectors that have this function.

Lens Type
Specify the lens part number.
This function can be used only for projectors that have this function.

Lens ID
Specify ALL or a value within the range of 1 to 255 for the ID used for lens identification.
This function can be used only for projectors that have this function.

Lens Name

Specify the lens name.
A name can consist of a maximum of 12 characters including letters, numbers, hyphens, and periods.
This function can be used only for projectors that have this function.

39



Adjustment and Settings Lens Settings

@ Active Focus
Enable or disable the active focus optimizer function.
This function can be used only for projectors that have this function.

@ Focus Offset
Set the focus correction amount for when the maximum specified brightness has entered the lens or when little light
enters the lens in Bright and Dark, respectively.
This function can be used only for projectors that have this function.

@ Test Pattern
Select the test pattern for adjustment with the active focus optimizer function.
This function can be used only for projectors that have this function.

@) Initialize

Initialize the Focus Offset value.
This function can be used only for projectors that have this function.
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Geometry Correction

Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected.
By adjusting the number of grids or number of control points, the images can be made to look more natural.
Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine
corrections.
® Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical
direction.
® Select the control point and then press the cursor key while holding down the Ctrl key to move it in increments of 0.2 pixel.
Select the control point and then press the cursor key while holding down the Alt key to move it in increments of 4 pixels.

When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost.
It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of
grids be displayed to make fine adjustments.

Geometry screen
191

Wl Geofhetry Manager Pro - ] x
Fi\el Edit  View | Tools  Version
= = E| Q= [EEEEEE] i@ AuTo ADIUST B

Lens Setting || Geometry  Edge Blenging | Uniformity | Brightness Control | Color Matching | Masking | mput Signal | Other

®

02 PROJECTORZ (0.0.0.2)
03 PROJECTORZ (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
0s PROJECTORS (0.0.0.5)
06 PROJECTORSE (0.0.0.6)

o7 PROJECTORT (0.0.0.7)
b e I
I O I
I O I

Power ON Standby
Shutter Close Shutter Open @
0SD ON 0sD OFF
Status ON Status OFF
Status Page = Prev Next

Test Pattern

OFF v

Grid Resolution

" ~oXm ~
[[J use Sguare Grid

Display Grid Lines

oFF ~

Cursor Information
Display Cursar

Coordinate Information S &

(g) None WMoving Area

Q T i =

L) Absolute Pc1 P 1 0 Z | [Jsmoothing [7] Alert Distortion Store A4

(_) Relative

Free Grid @

T e | EAQ Q@Y

[ Auto Transfer

w174

(1) sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
® The red frame around the Sub Window indicates the display range in the editing area.
® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

@ Zoom In

Zooms in to the editing area.

@ Zoom Out
Zooms out the editing area.
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®

®

White

This corrects the RGB color components together.
Red, Green, Blue

These correct only the component of the selected color.

Editing Area

The image can be corrected by selecting the grid using the mouse.

The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected.

Operation Area

This is where the buttons, slide bars, etc. used by geometry correction are displayed.

The operations that they perform differ depending on which correction pattern has been selected.
&= “Operation area” (page 43)

Edit, View
The following menu items can be used on the Geometry screen.

Geometry Correction

Edit submenu
Lock
Locks the control points of the grids selected.

A locked control point will not move even if the correction pattern has been changed.
The lock will not be released even if the number of grids has been changed.

Unlock
Unlocks the control points that have been selected.

Free
Click to release the control point selection.

Reset
Click to return the selected control points to the initial status.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu

Grid Resolution
Use Square Grid
This makes it possible to select the combination of the number of grids which can be selected when a check
mark has been entered for || Use Square Grid in the common operation area.
X
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.

Y
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
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Geometry Correction

m Operation area

© @
| I

I Mowing Area
PC-1 w []

g

i
EE rl-ISmuUthing
he?

Free Grid

S

@ Mode Switching
OFF: Disables geometry correction.
PC-1/PC-2/PC-3: Enables geometry correction.

Alert Distortion

When geometry correction is enabled, only one piece of data (PC) can be saved for some models.

@ Moving Area

Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.

@ Smoothing

Correction using curves can be performed when a check mark is entered in (! Smoothing

Example when the check mark is entered

Example when the check mark is not entered

@ Alert Distortion

If a setting exceeding the geometric distortion limit is sent to the projector when |¥/| Alert Distortion has been checked, an
error message will be displayed on the dialog screen. The error message will be displayed on the status bar if a check

mark has been entered in || Auto Transfer.
|¥| Alert Distortion is checked as the default setting.

When a check mark is not entered for || Alert Distortion | even settings exceeding the geometry correction limits can be
sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.

@ Store

Click this button to save the current settings inside the projector after they have been reflected in the projector.

A screen for selecting the save folder inside the projector may appear for some models.

®) Display Switching

Click _¥_| to minimize the operation area; conversely, click A | to maximize it.
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Selecting the control points

Select the Geometry screen and switch the mode to other than OFF. The control points can now be selected.
& “Free Grid (Free-form correction)” (page 45)
Drag the control points to move them. The control points cannot be moved by selecting the lines.

.l.l. The control points can be selected using lines by
I clicking the space between one point where the grids
------I intersect and another such point.

RS EEENEREEE The control points can be selected using a multiple
=- number of lines by dragging and enclosing the
spaces between one point where the grids intersect
and another such point.

BN '/hen a point where the grids intersect is clicked, it

“III' can be selected as a single control point.

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected
control point keeps selected.

To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or
press the cursor key while holding down the Shift key.

To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit
submenu displayed by right-clicking.

Right-clicking

The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse
is clicked.

The menu functions are the same as with the Edit submenu.

&= “Edit submenu” (page 42).

Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal
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Free Grid (Free-form correction)

The Free Grid operation area is where the operations for all the correction patterns are selected.
The corrections made with Free Grid are also reflected in the editing area of the other correction patterns.

Moving Area

PC-1 ~ | 0 < | [Osmoothing [ Alert Distortion Store hd

e

Free Grid

@ Correction Patterns
Any of the following correction patterns can be selected.

Free Grid (free-form correction)

4 Corner (4-corner correction)

Keystone (keystone shape correction)

Cylindrical screen (cylindrical shape correction)

Elliptical screen (elliptical shape correction)

Spherical screen (spherical shape correction)

Rotation (rotational correction)

The Upgrade Kit (ET-UK20) must be applied on the selected projector to enable the Auto Screen Adjustment
function.

& “Activation” (page 12)

4 Corner (4-corner correction)

The positions of the four corners of the image are set with this type of correction.

Moving Area 1
PC-1 s [ | 0 + [smoothing [ Alert Distortion Store I Import from CORNER CORRECTION I v
4 corner
r‘l r" [‘ O q\ e 1/1 Linearity | []{Aute
o 1= . . . o T v 1 ] = Reset
Upper Left | v 1 0 o Reset UppepRigatdv 1 0 = Reset H 1 0 = Reset
H 1 0 - = H | 0 = Reset Pincushion | Upper 1 0 = Reset
Lowef Lett | v 1 0 = Resst Lowdr Right v 1 0 = Reset Lower 1 0 S Reset
H 1 0 = Reset H 1 0 = Reset Left 1 0 = Reset
| | Rotathn [d ree]l 1 000 l Reset [ |Fit Sizel Right 1 0 $ Reset
z
@ @ ® ®@® ® ® @ @ ®

@ Upper Left
Set the horizontal and vertical positions of the upper left.
Setting ranges V (vertical position):  -400 to 600 (when the resolution of the projector is 3840x2400 dots)
-200 to 600 (when the projector resolution is other than the above)
H (horizontal position): -400 to 768 (when the resolution of the projector is 3840%2400 dots)
-200 to 600 (when the projector resolution is other than the above)
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@

Lower Left
Set the horizontal and vertical positions of the lower left.
Setting ranges V (vertical position):  -600 to 400 (when the resolution of the projector is 3840%2400 dots)
-600 to 200 (when the projector resolution is other than the above)
H (horizontal position): -400 to 768 (when the resolution of the projector is 3840x2400 dots)
-200 to 600 (when the projector resolution is other than the above)
Upper Right
Set the horizontal and vertical positions of the upper right.
Setting ranges V (vertical position):  -400 to 600 (when the resolution of the projector is 3840%2400 dots)
-200 to 600 (when the projector resolution is other than the above)
H (horizontal position): -768 to 400 (when the resolution of the projector is 3840x2400 dots)
-600 to 200 (when the projector resolution is other than the above)

Lower Right
Set the horizontal and vertical positions of the lower right.
Setting ranges V (vertical position):  -600 to 400 (when the resolution of the projector is 3840%2400 dots)
-600 to 200 (when the projector resolution is other than the above)
H (horizontal position): -768 to 400 (when the resolution of the projector is 3840%x2400 dots)
-600 to 200 (when the projector resolution is other than the above)

Reset
Click these to reset the respective settings which have been changed.

Rotation [degree]*
Set the rotational angle of the image here.
Setting range: Enter a setting from —10.0 to 10.0.

Fit Size*

Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size | the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.

Linearity

Set the linearity in the horizontal and vertical directions.

When a check mark is entered for ] Auto , the linearity values are determined automatically from the positions of the
upper, lower, left, right, and four-corner points. In this case, values cannot be set.

Setting range: - 127 to 127

This function can be used only for projectors that have this function.

Pincushion
Set the pincushion independently for upper, lower, left, and right.
Setting range Upper: -100 to 100*' (-50 to 50)*2
Lower: -100 to 100*' (-50 to 50)*2
Left: -100 to 100*" (-50 to 50)*?
Right: -100 to 100*' (-50 to 50)*?
*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

Import from CORNER CORRECTION

Reflect the [CORNER CORRECTION] and [CORNER/PINCUSHION] adjustment items in the OSD menu of the projector.
This is available only for models that have the CORNER/PINCUSHION and CORNER/PINCUSHION adjustment
functions in the projector.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
&= “Activation” (page 12)
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Keystone (keystone shape correction)

Images are corrected using the keystone shape as the reference with this type of correction.

Moving Area
PC-1 ~ 1 E | [smoothing [2] Alert Distortion store | | Import from KEYSTONE H—|—
Keystone Setting
r“l (”" “Eim Q\ e l/" Lens Throw Ratio 20 =|[ Reset
o L W R C‘- . o 1=y W Keystone [degree] 0.0 = Reset
E‘ i A (oo - Reset H Keystone [degree] T E Reset
- WVArc 0.0 = Reset
E I @ I:D'D hd A=z HaArc 0.0 = Reset
@ I @ 0 = Reset V Balance 0 = Reset
& I & 0 = Reset H Balance i = Reset
— | | Rotation [degree] 000 = Reset ] Fit siz
| | |
@ @ ©) @ @ ®

@ Correction pattern adjustment area

®

The following settings are selected here:

® Vertical: —45.0 to 45.0*" (-40.0 to 40.0)*?
® Horizontal: —40.0 to 40.0*' (-15.0 to 15.0)*2
® Vertical balance: —60 to 60

® Horizontal balance: —30 to 30

The numbers in parentheses serve as the setting ranges if the selected projector has not been activated.

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

Reset
Use these to reset the settings that have been changed.

Setting
The following settings are selected here:

Lens Throw Ratio: 0.7 to 16.5

V Keystone [degree]: —45.0 to 45.0*" (-40.0 to 40.0)*?
H Keystone [degree]: —40.0 to 40.0*' (-15.0 to 15.0)*?
V Balance: —60 to 60

H Balance: —30 to 30

Rotation [degree]*: —10.0 to 10.0

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.

Import from KEYSTONE
Reflect the correction results of [KEYSTONE] in the OSD menu of the projector.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
&= “Activation” (page 12)
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Cylindrical screen (cylindrical shape correction)

Images are corrected using the cylindrical shape as the reference with this type of correction.

Moving Area
PC1 ] [0 2| [Jsmoothing [7AkrtDistortion | Store ||| import from CURVED CORRECTION
Cylindrical screen _Setting
F-‘l r" (( m Q\ e (/1 Lens Throw Ratic 2.0 = Reset
of 1= . O. . o I V Keystone [degree)] 0.0 = Resst
H Keystone [degree] 0.0 = Reset
. - = VArc 0.0 = Reset
i}j | :?_:j{ [00 2] Reset HAre 0.0 2 Reset
i I E 0.0 = Reset  Balance 0 = Reset
H Balance 0 = Reset
Rotation [degree] 0.00 = Reset i S
| |
©) @ ©) @ @ ® 6

@ Correction pattern adjustment area
The following settings are selected here:

® Vertical arc: —100 to 100*" (—50 to 50)*?
® Horizontal arc: =100 to 100*" (=50 to 50)*2

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

@ Reset

Use these to reset the settings that have been changed.

@ setting

The following settings are selected here:

Lens Throw Ratio: 0.7 to 16.5

V Keystone [degree]: —45.0 to 45.0*" (-40.0 to 40.0)*2
H Keystone [degree]: —40.0 to 40.0*" (-15.0 to 15.0)*2
V Arc: =100 to 100*! (=50 to 50)*?

H Arc: =100 to 100*! (=50 to 50)*?

V Balance: —60 to 60

H Balance: —30 to 30

® Rotation [degree]*: —10.0 to 10.0

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

@ Fit Size*

Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for D Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
&= “Activation” (page 12)
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(B Import from CURVED CORRECTION
Reflect the correction results of [CURVED] in the OSD menu of the projector.

@ Maintain Aspect Ratio
When a check mark is entered for [| Maintain Aspect Ratio | correction is made so that the aspect ratio of the projected
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.
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Images are corrected to fit a screen whose shape is
elliptical when viewed from above.

Moving Area
PC-1 w | [[] smocthing [] Alert Distortion v |
Elliptical screen Setting
c\ e r;’ Lens Throw Ratio 20 || Reset
R e e V Keystone [degree] | 0.0 5[] Reset
]
[a] H Key [degree] 0.0 = Reset
= Width/Radius Ratio 001 5|||  Reset
= teset Flattening 100 H || Reset
Reset || |azimutn 0.0 5| Reset
Reset | W Balance ] %‘ Reset Maintain Aspect Rati
| Rotation [degres] 0.00 fll Reset Fit Siz

@ Correction pattern adjustment area
The following settings are selected here:

® Width/Radius Ratio: 0.01 to 1.20
® Flattening: 0.50 to 2.00

® Azimuth: —45.0 to 45.0

® Vertical balance: —60 to 60

@ Reset

Use these to reset the settings that have been changed.
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@ Setting

The following settings are selected here:

Lens Throw Ratio: 0.7 to 16.5

V Keystone [degree] (Vertical keystone correction): —45.0 to 45.0*' (-40.0 to 40.0)*?
H Keystone [degree] (Horizontal keystone correction): —40.0 to 40.0*' (=15.0 to 15.0)*?
Width/Radius Ratio: 0.01 to 1.20

Flattening: 0.50 to 2.00

Azimuth: —45.0 to 45.0

V Balance: —60 to 60

® Rotation [degree]*: —10.0 to 10.0

It may not be possible to correct the images depending on how the settings are used in combination, such as a small
lens throw ratio (lens with a short focus) and keystone correction with a wide angle.

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

@ Fit size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

@ Maintain Aspect Ratio
When a check mark is entered for [ Maintain Aspect Ratio Aspect Ratio, correction is made so that the aspect ratio of the
projected image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
& “Activation” (page 12)
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m Description of elliptical screen (elliptical shape correction) parameters

View of projector as seen from above

Tangent - " \idth/Radius Ratio -

Screen

N HKeystone [degree]

Flattening
|
i Horizontal radius of
ellipsis
Example of settings
Setting item Calculation method Setting
Lens Throw Ratio Projection distance + width of image on flat screen 0.9
=3870 mm + 4 300 mm
H Keystone [degree] Angle formed with tangent of projection center 14.0
Width/Radius Ratio Width of image on flat screen + radius in horizontal direction of ellipsis 0.69
=4 300 mm +6 200 mm
Flattening Radius in vertical direction of ellipsis + radius in horizontal direction of ellipsis 0.66
=4 110 mm + 6 200 mm
Azimuth Position of projected image center on ellipsis 40.0

Tangent --._

Screen

4110 mm

Projector

| 6 200 mm
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Spherical screen (spherical correction)

Images are corrected using the spherical shape as the reference with this type of correction.

Moving Area

PC-1 & | E =) Osmoothing [ Alert Distortion Store L
Spherical screen Setting
F“l l/“ ﬁ Q\ MF Lens Throw Ratio 2.0 e Reset
of I o . 0- of i W Keystone [degree] 0.0 = Reset
H Keystone [degree] oo = Reset
WV Arc T S Reset
@ I E \L HArc 0.0 = Reset
W Balance i = Reset
H Balance 0 : Reset
Rotation [degree] 0.00 = Reset Fit Size)
| | |
@ €) @ @® 6

@ Correction pattern adjustment area
The following settings are selected here:

® Vertical arc and horizontal arc: =100 to 100*! (=50 to 50)*2

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

@ Reset

Use these to reset the settings that have been changed.

@ Setting

The following settings are selected here:

Lens Throw Ratio: 0.7 to 16.5

V Keystone [degree]: —45.0 to 45.0*" (-40.0 to 40.0)*?
H Keystone [degree]: —40.0 to 40.0*' (-15.0 to 15.0)*?
V Arc: =100 to 100*' (=50 to 50)*?

V Balance: —60 to 60

H Balance: —30 to 30

® Rotation [degree]*: —10.0 to 10.0

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
&= “Activation” (page 12)

@ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

@ Maintain Aspect Ratio
When a check mark is entered for [ | Maintain Aspect Ratio | correction is made so that the aspect ratio of the projected
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
& “Activation” (page 12)
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Geometry Correction

Rotation (rotation correction)

Images are rotated with this type of correction.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
& “Activation” (page 12)

Mowving Area
PC1 v 1 [0 ]| Osmoothing Akt Distortion | Store
Rotation Setting
F1 lofj ﬂ Q\ e “ﬁ Lens Throw Ratio 2.0 = Reset
of I . 0. . ol . W Keystone [degree] 0.0 = Reset
H Keystone [degree] 0.0 = Reset
= W Arc 0.0 = Reset
% I ﬁ |D'UD z I fese I HArc 0.0 = Reset
\/ Balance | = Reset
H Balance 0 = Reset
Rotation [degree] 0.00 = Reset Fit Sizg|
| | |
@® @ ©) @ @

@ Correction pattern adjustment area
The following settings are selected here:

® Gradient: —10.0 to 10.0

@ Reset

Use these to reset the settings that have been changed.

@ Setting

The following settings are selected here:

® Rotation [degree]: —10.0 to 10.0

@ Fitsize

Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds

the projection area.
The image will not be reduced if a check mark is not entered.
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Edge Blending

Edge Blending

Edge Blending screen

@

@®

®

S

02  PROJECTORZ (0.0.0.2)
03  PROJECTOR3 (0.0.0.3)

01  PROJECTORI (0.0.0.1)

User

Lens Seffng | Geomedy |[£ad

~ | [ Marke]

Blending  Uniformi

Brightness Control | Color Mat

B Gecfretry Manager Pro m} X

File View Tools Version

=B 6 B Q& O [T W@ AuTo ADIUST L
L

ning | Masking Inpu(S\gnall umer|

Non-Overiapped Black Level

[ interiocked

Black Border Level
[ interlocked

OFF

Cursor information

R 0 z
04 PROJECTOR4 (0.0.0.4) _
05 PROJECTORS (0.0.0.5) € 0 =
08 PROJECTORE (0.0.0.8) B 0 e
y y -
07 PROJECTOR? (0.0.0.7) e
08 PROJCCTORD (0.0.0.0) User Biendig Curve: Uefaut [AEnatie
A De Rename Start | 0
Seffing  em—
Display Prujeclor Nane: Ray) 172
@ Blauk Burder | 0
T — Keystone Area | 0
Shutter Close Shutter Open Left
[ Enable
0SDON 0SD OFF Start | 97 =
Status ON Status OFF width | 200 =
Status Fage | Hrev Hext Black Border | 474 5
@ TESTEITET Keystone Area | -389 (=
OFF v Cveilapped Black Level
Interiocked
Grid Raeolution =
R [] =
1 ~| x [1n v - A -
["use Sauare G G 7 =
Display Grid Lines =

R o
G 0
B 0
—_——

Overlapped Black Level
[ interlocked

Right
[ Enable
Start [ 0
widtn | 128
Black Border | 0

e el

Kevstone Area | 0

Oweilapped Black Level
Interlocked
R
G
B

FEISES

Lower
[JEnatie

ey
Coordinate Information
Non

Zerefe:

Manual Iransier

[ Auto Transfer

@ Mode Switching

OFF:

The edge blending settings are canceled.

ON:

Makes the edge blending settings effective.

User:

x1/4

Adjusts settings for edge blending using the user-defined curve.

@

Right
Enable
Start

Width
Black Border

Keystone Area

=

Owerla EEed Black Leve| em— @

Interlocked
R
G
B

=

=

=

Ak e

When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

Marker

When a check mark is entered in [_| Marker | markers are displayed in the editing area and on the images projected from

projector.

The start position for edge blending is indicated by display of a green line, and the edge blending width is indicated by

display of ared |
&= “Editing Area

Setting

ine.
” (page 57)

Click this button to display the user-defined curve setting screen.
&= “User-defined curve setting screen” (page 58)

Upper

The upper side settings of the projected image are set here.
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®
®
@

€)
Q)

Left
The left side settings of the projected image are set here.

Right

The right side settings of the projected image are set here.
Lower

The lower side settings of the projected image are set here.
Enable

Put a check mark is entered in |_|Enable to create blending settings for that edge. Only the edge blending settings for
those items with a check mark entered in |_|Enable take effect.

When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the

Upper, Lower, Left and Right Enable boxes.

Start
The starting position of edge blending is set here.

Width
The width of the edge blending is set here.

Black Border (Outside Area)
Set the border width of the black level.
[Outside Area] may be displayed in place of [Black Border] for some models.

Keystone Area
Set the slope of the black level border when using the edge blending at the same time as the keystone correction.
This function can be used only for projectors that have this function.

Overlapped Black Level (Bright Blending)

The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.
Setting range: 0 to 255

[Bright Blending] may be displayed in place of [Overlapped Black Level] for some models.

Interlocked
When a check mark is entered for [¥] Interlocked | Overlapped Black Level can be set with the Red, Green and Blue values
all linked together.

Non-Overlapped Black Level (Bright Inside)

The black level inside the area where the images are to be superimposed is set here.

When a check mark is removed from [¥] Interlocked , the Red, Green and Blue values can be set separately.
[Non-Overlapped Black Level] may be displayed in place of [Bright Inside] for some models.

Black Border Level (Bright Outside)
Set the black level of the parts where images are superimposed.

When a check mark is removed from [] Interlocked , the Red, Green and Blue values can be set separately.
[Black Border Level] may be displayed in place of [Bright Outside] for some models.
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@ Editing Area
The edge blending setting status is displayed here.
By dragging these markers, the start position of the edge blending (green), edge blending width (red), and black level

border width (yellow) can be set.
The settings established with Upper, Left, Right and Lower are also reflected in this area.

The line for the black level border width (yellow) is displayed only when the mouse cursor is positioned on the marker
(yellow).

Start (Edge blending start position)

Black Border (Black level border width)
Width (Edge blending width)

1 Edit

In addition to the menu items described in “Main menu” (page 25), the following menu items can be used on the Edge
Blending screen.

Edit submenu

Flip Vertical:
Click to flip vertically the correction status of the entire image.

Flip Horizontal:
Click to flip horizontally the correction status of the entire image.
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User-defined curve setting screen

When [Setting] is clicked, the user-defined curve setting screen is displayed.

The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.

When a user-defined curve setting is changed from the initial curve, the display above [Setting] changes from [User Blending
Curve: Default] to [User Blending Curve: Changed].

@
@

Geometry Manager Pro X
Gain Blendng
®Upper
OLeft
= N ®
O Lower
() Right
Copy
From Upper
To Lower H— @
Copy
Gamma
| L—03)
/ il
Store I (: )
Reset I
oK il
Apply —— @
Cancel I .

Blending
The position where the user-defined curve is to be set is selected here.

Copy
Click this to copy the current user-defined curve setting.
The setting is copied from top to bottom (or vice versa) or from left to right (or vice versa).

Gamma
The user-defined curve is set here.
For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).

Initial Curve
The initial setting of the user-defined curve is displayed here.

Correction Curve
The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).

Store

Click this to reflect the currently displayed user-defined curve setting in the projector and save the setting in the projector.
The setting remains saved even when the main power of the projector has been set to “off”.

Reset
Click this to reset the currently displayed user-defined curve setting and return it to the initial value.
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® ok

Click this to reflect the user-defined curve setting in the projector and close the user-defined curve screen.
This operation is reflected in the projector even when a check mark has not been entered in ("] Auto Transfer.

@ Apply

Click this to reflect the user-defined curve setting in the editing area.

This operation is reflected in the projector even if a check mark has not been entered for ("] Auto Transfer.

Cancel

Click this to cancel the setting and close the user-defined curve screen.

59



Adjustment and Settings Uniformity

Uniformity

Two correction methods can be used for uniformity.

B Gradient Correction

When unevenness in color occurs in one direction across the image, greater uniformity can be obtained by applying
correction in the vertical or horizontal direction.

Correction is performed by toning down (thinning) the selected color in a gradient-like manner from one side of the image to
the other.

H Flexible Correction

If other than OFF was selected in Flexible Correction, correction can be performed by specifying ranges for the localized
unevenness of colors in the image.

When the image contains localized unevenness in color, correction is applied after specifying the range.

As with Gradient Correction, correction is performed by toning down (thinning) the selected color in a gradient-like manner.
&= “Flexible Correction Procedure” (page 63)

To use the Flexible Correction function, the upgrade kit (ET-UK20) must be applied on the selected projector.

& “Activation” (page 12)

Uniformity screen

| | ? |
Bl Gedmetry Manager Pro - O X
File View Tools Versicn
28 ¢ = o = [(O)&)E] [FHEEEEEET @@ AuTo ADIUST [l

’-'mformity Brightness Control Colormalcning‘ r.|asking‘ Input 5igna\| Other

L Lens Sefting | Geometry | Edge Blending
0z PROJECTORZ (0.0.0.2) "
03 PROJECTOR3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
08 PROJECTORSG (0.0.0.6)
o7 PROJECTORT (0.0.0.7)
08 PROJECTORS (0.0.0.8)

Add De Rename

Display Projector Name

Power ON Standby
Shutter Close Shutter Open
0SD ON 0SD OFF
Status ON Status OFF

Status Page = Prev Next

Test Pattern

OFF -

Grid Resolution

11 ~ XN ~
v
@ [ use square Grid
— >
Display Grid Lines
@ OFF )
. Flexible Correction Gradient Correction
@ Cursor Information oFF TR e pmefi] Display on PC (Lamp 1 fLampszampafLamM,__@
Display Cursor White 1 o L Reset
@ Coordinate Information White H 1 0 - Reset
— =
® None Red v 1 0 = Reset
() Absolute Red H 1 0 2 Reset
Relative Green V ] 0 = Reset
Transfer Green H 1 0 > Reset
Generate from Geometry =
Manual Transfer [1 Blue vV 1 o = Reset
G T | =
[ Auto Transfer I mm I: Blue H 1 o - =
x1/4
a 5 ®® ® @®
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@ Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
The Sub Window displays a representation of the Gradient Correction and Flexible Correction settings for the entire
projection area.
® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

@ Zoom In

Zooms in to the editing area.
The center of the target area is zoomed in when the target area has been selected in the editing area.

@ Zoom Out
Zooms out the editing area.

@ Editing Area
A representation of the Gradient Correction and Flexible Correction settings is displayed.
When applying Flexible Correction, this is where you select target points and set the target area.

@ Gradient Correction
When applying gradation to the entire image, set the degree of color variation.
You can set this individually for each of the colors White, Red, Green and Blue, both for the vertical direction (V) and the
horizontal direction (H).
For numerical value input: Enter a value from -127 to 127.
® How the vertical (V) and horizontal (H) gradation slopes varies depending on the model. For details, refer to “Settings”
- “[DISPLAY OPTION] menu” - “[UNIFORMITY]” in the operating instructions of the projector.

@ Display on PC
When you put a check in (/] Display on PC , the Gradient Correction settings are applied in the editing area.
Put a check here when you want to see the combined effect of Gradient Correction settings and Flexible Correction
settings in the editing area.
When the check is removed from [ | Display on PC , the Gradient Correction settings are not applied to display in the editing
area. The settings will still be reflected in the projector, however.

@ Lamp Status
When a projector that uses a lamp as light source is selected, this indicates the lamps that are currently lit.
[None] is displayed if none of the lamps is lighted.

Reset

Return the Gradient Correction and Flexible Correction settings to their default values.

@ Switch mode
OFF: Disable the Flexible Correction settings.
ON(Pre): Enable the Flexible Correction settings and process before geometry correction.
ON(Post): Enable the Flexible Correction settings and process after geometry correction.

The selection options may be [OFF] and [ON] depending on the model.

Right-clicking

If other than OFF was selected in Flexible Correction, clicking the right button of the mouse in the editing area displays
a menu with following items. The functions of these items are the same as with the Edit submenu items.

&= “Edit submenu” (page 62)

Reset, Flip Vertical, Flip Horizontal, Area Select, Point Select

61



Adjustment and Settings Uniformity

Flexible Correction

When correcting partial unevenness in image color, you can set the degree of the change in the gradation color to be
applied to the area surrounding the selected target point.

This setting can be made individually for each of the three colors Red, Green, and Blue.

Setting range: 0 to 1023

Interlocked

By putting a check in [¥] Interlocked | you can set Flexible Correction to link the value set to all three of colors Red, Green,
and Blue.

Store
Reflects the gradation settings in the projector and saves them in the projector.
The settings are maintained even when the main power of the projector has been turned off.

Factory Default
Discard the current Flexible Correction settings and initialize to the factory default state.

Generate from Geometry

Generate the data of Flexible Correction based on the adjustment data of geometry correction.

If you select the adjustment data of geometry correction to reference, a selection screen appears for selecting whether or
not to display in combination with the Flexible Correction data currently being adjusted or to discard that data and create
new data.

Gamma

Perform inverse gamma correction to remove gamma value influence.
Setting range: 1.0 to 2.8 (in 0.1 steps)

Adjustment may not be possible depending on the model.

Edit

In addition to the menu items described in “Main menu” (page 25), the following menu items can be used on the
Uniformity screen. However, these menu items are valid only when the Flexible Correction method is used for correction.

Edit submenu
Reset
Return the Gradient Correction and Flexible Correction settings to their default values.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.

Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Area Select
While an area is selected, its control points are displayed.
The target area can be enlarged or reduced or moved using the control points.
® [Area Select] cannot be selected concurrently with Point Select.

Point Select
Confirms settings for the target area currently being set.

® [Point Select] cannot be selected concurrently with Area Select.
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Flexible Correction Procedure

Select the target point from which gradation is to be applied, and then specify the target area (the range to be corrected) and
apply correction. When doing this, specify the points at which grid lines cross as target points.

-_—

Editing area

Target point

]
-l

Target area

Operation point

Select other than OFF in Flexible Correction and enable the Flexible Correction settings.

Click or drag the mouse to select a target point.

You can also select multiple target points at the same time.
A red frame is displayed around the perimeter of the area defined by the selected target points, and this becomes the
target area (the correction area).
* The target area and target point can be selected using the same method as for the control points of the geometry
correction grid.
&= “Selecting the control points” (page 44)
Adjust the parameters.
Gradation is applied to the selected color in the target area defined by the target points is such a manner that the color is
toned down toward the periphery of the area.
Right-click and select [Area Select], and display the operation points (green) in the target area.

Using the mouse, drag the operation points to enlarge or reduce the size of the target area.
If the mouse cursor is placed in the target area and then dragged, the target area can be moved.
® [Area Select] can also be selected on the Edit submenu.

Enlarging or reducing the size of the target area does not change the number of selected target points.

Right-click to select [Point Select], and release the operation point display.

® [Point Select] can also be selected on the Edit submenu.

[Point Select] and [Area Select] can be toggled by pressing the space key.

Repeat the above steps when you want to apply correction to multiple target areas.

Where the target areas overlap, correction will be applied by multiplying the respective settings.
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Brightness Control

Brightness Control

When a single image is configured using a multiple number of projectors, the brightness levels of the images projected from
the projectors may not be consistent. If this is the case, adjust the projectors so that the brightness levels are made consistent.
The brightness correction can also be done automatically at periodic intervals.

Brightness Control screen

©

@O® WO

@

@ The items displayed will vary depending on the projector you are using.
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Brightness Control Gain

Lens Setting | Genmetry| Edge Blending | Unifl:lrrn'rty| Brightness Control  Color Ma

Brightness Control Gain

e

This is where the projector brightness is set.
The brightness of the image projected from the projectors is set according to the numerical value that is set here.

Operating Mode

Lens Setting | Geumetry| Edge Blending | Uniformity | Brightnezs Contrel  Color Matching | Maskin

Operation Setting

Operating Mode

Max Light Output Level

Light Output

MNormal

1000 =

I 1000 [2

This is where the operating mode of the projector is set.
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@

€)

@

®

High:
This reduces the life of the light source more than Normal, but select this when a higher level of brightness than
Normal is required.

Normal:
Select this when a high level of brightness is required.

Eco:
This mode produces a lower brightness than in [Normal] mode, but extends the life of the light source.

Long Life1/Long Life2/Long Life3:
These modes produce a lower brightness than in [Eco] mode, but extend the life of the light source.

User1/User2/User3:
These modes allow you to configure separate [Max Light Output Level] and [Light Output] settings.

Max Light Output Level:
This allows you to adjust the upper limit for brightness correction of the screen based on the change in brightness of
the light source.

Light Output:
This allows you to adjust the brightness of the light source.

For details, refer to the operating instructions of the projector.

Mode

This is where the brightness correction mode is selected.
OFF:
The brightness is not corrected.

Auto:

The brightness levels of the images projected from the projectors are corrected by the brightness sensors of the
projectors.

For details, refer to the operating instructions of the projectors concerned.

PC:

The brightness levels of the images projected from the projectors are corrected using the “Multi Monitoring &
Control Software”.

For details, refer to the Operating Instructions of “Multi Monitoring & Control Software”.

Link

This is where the link mode is set.

The mode is enabled when [Auto] has been selected as the Mode setting.
OFF:
The brightness level of the selected projector is corrected.

Group A/Group B/Group C/Group D:

The brightness levels of the projectors in the respective group are corrected.
The groups are set using the network function of the projectors.

For details, refer to the operating instructions of the projectors.

Calibration Message

When a check mark is entered for [¥] Calibration Message | 5 message is displayed while measuring the brightness levels for
correcting the brightness.

Some models do not support this function.

Chroma Correction

When a check mark is entered for [¥|Chroma Correction | color is adjusted together with brightness.
Some models do not support this function.
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@ Calibration Time
The time at which to start measuring the brightness levels for correcting the brightness is selected here.

The time can be set when a check mark is entered for [¥] Calibration Time .
Some models do not support this function.

@ Apply

Click this to reflect the brightness control setting in the projector.

Status

Brightness correction-related errors are displayed here.

Status Error Description
Brightness sensor error Something is wrong with the brightness sensor (projector).
Red The brightness cannot be measured. The brightness cannot be corrected due to a factor that is not
Please check the status of the projector. | related to the brightness sensor.
Yellow The brightness can no longer be The brightness that can be corrected by the projector is
corrected by a significant margin. reaching its limit.
Green No Error Normal condition.

@ Update

Click this button to check the projectors and update the Status displays.
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Color Matching

When configuring a single image using a multiple number of projectors, the coloring of the image projected from the various
projectors may not be consistent. If this is the case, adjust the projectors to match the coloring.

Color Matching screen

| Geometry Manager Pro - O ®
File Edit View Tools Version
2 e 6| |m|o = o [FEEEEEET @@ AT ADJUST
+ 4 Lens Sefting ‘ Geometry ‘ Edge Blending | Uniformity | Brightness Contrul| Color Matching  Masking | Input Signal | Other
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Display Projector Name Red Green Blug Cyan Iagenta Yelow White
Red 2048 12 0 = ] = 0 = 2048 = 2048 = 2048 =
Power ON Standby i3 i3 z i3 z z =z
Green § 0 B 2048 = 0 - 2088 = 0 - 2048 = 2048 = @
Shutter Close Shutter Open = = 2 = 2 2 k2
Blue 0 + 0 + 2048 % 2048 2 2048 % 0 - 2048 =
0SDON 050 OFF = = = = = = =
Status ON Status OFF 708 Mode / Measurement
Status Page | Prev || Next Measurement Data
Black Red Green Blue White
2o == =1 ==
Test Pattern B * - a -
Y 0
OFF ~
x  fooor = 0001 = 1 E o1 1= W= @
Grid Resolution
= ® x [ » ¥ 0001 = 0001 = 0.001 = 0001 2 0.001 =
[Juse square Grid Target Data
Display Grid Lines M Grﬂ BILE C an I.|agema wa White
OFF hd ¥ 0 = 0 = 0 o 0 = 0 - 0 - 0 -
ELCTI G x 0.001 : 0.001 : 0.001 : 0.001 : 0.001 : 0.001 : 0.001 : @
[ Display Cursor
e e ¥ ooo1 oot 0001 7 ooor oom 7 0001 7 ooo1 7
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Relative
Transfer
[ Manual Transfer
[] Aute Transfer
x1/4

The items that can be adjusted, setting details, and setting range vary depending on the model.

@ Mode

The color matching mode is selected here.

OFF
Color matching is not performed.

3 Colors
The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).

7 Colors

The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow
and White).

709 Mode

The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.

The Target Data values are fixed.

709 Mode cannot be selected for some models. For details, refer to the Operating Instructions of the projector.

Measured

The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.

The Target Data values can be adjusted.

For details, refer to the Operating Instructions of the projector.
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@ 3 Colors

The Red, Green and Blue values are set here.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The White value can be set in addition to the Red, Green and Blue values for some models.

@ 7 Colors

The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [7 Colors] has been selected as the Mode setting.

@ Measurement Data
The Black, Red, Green, Blue and White values are set here.
The settings take effect when [709 Mode] or [Measured] has been selected as the Mode setting.

@ Target Data
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [Measured] has been selected as the Mode setting.
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Two kinds of masking are available.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
&= “Activation” (page 12)

H Line Masking

The shape to be masked is set by moving the operation points on the four sides—top, bottom, left and right—of the projected
image.
The area to be masked can also be inverted between positive and negative.

m Bitmap Masking

The bitmap in the 1-bit monochrome format is loaded and set as the masking data.

The position and size of the masking can be changed.

Bitmaps from 8 x 8 pixels to 1920 x 1200 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050
dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned) are supported.

The *.bmp and *.dib file extensions are supported.

The area to be masked can also be inverted between positive and negative.

® The Line Masking and Bitmap Masking settings can be used simultaneously. In that case, masking applies to the each area
set in the settings.
® When the input signal of the projector is changed, retransmission to the projector may be required.

Masking screen

@ GI) C%) CTD @DOB®Y
Bl Geonfetry Manager Pro - O X
File lEd\t Viewl Tools  Version
28 ¢ (= = = = = = FFEFEEEEEH] W@ AuTo ADiusT B
r ¥ Lens Setting | Gaumetry‘ Edge Blending ‘ Umfurmrty| Brightness Control | Color Matching ‘ Masking  Input Slgna\| Other

0z PROJECTORZ (0.0.0.2)
03 PROJECTOR3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
0s PROJECTORS (0.0.0.5)
06 PROJECTORSG (0.0.0.6)
o7 PROJECTORT (0.0.0.7)
08 PROJECTORS (0.0.0.8)

Rename

Display Projector Name

Power ON Standby
Shutter Close Shutter Open
0SD ON 0SD OFF
Status ON Status OFF

Status Page | Prev Next
Test Pattern

OFF v

Grid Resolution
1 v XM v

[Juse square Grid
Display Grid Lines
OFF -

Cursor Information

Display Cursor

Coordinate Information
PC-1 ~

(®) None
() Absolute Line Maskin Bitmap Masking
O Relative Enable Enable
Transier Left Upper Right Lower
| Manual Transfer I Cinvert invert
[] Auto Transfer
«1/4
i
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)

©

Sub Window

Each time this is clicked, the Sub Window screen is switched between displayed and cleared.

An image of the entire projection area is displayed on Sub Window.

® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

Zoom In
Zooms in to the editing area.

Zoom Out
Zooms out the editing area.

Red
Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Red] on the View submenu.

Blue
Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Blue] on the View submenu.

Green
Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Green] on the View submenu.

Orange
Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Orange] on the View submenu.

Editing Area
Click the operation points to select them, and then drag them to form the shape that is to be masked.

Right-clicking

Clicking the right-mouse button in the editing area displays a menu with following items. The menu functions are the
same as with the Edit submenu.

&= “Edit submenu” (page 71)

Reset, Flip Vertical, Flip Horizontal

Mode Switching
OFF: Masking is not performed.
PC-1/PC-2/PC-3: Masking is enabled.

When masking is enabled, only one piece of data (PC) can be saved for some models.
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Edit, View
In addition to the menu items described in “Main menu” (page 25), the following menu items can be used on the
Masking screen.

Edit submenu
Reset
When Line Masking has been performed, the positions of the operation points are returned to their initial
statuses.
Returns to the status established when the bitmap has been loaded when Bitmap Masking is executed.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu
Mask Marker (Red, Green, Blue, Orange)
Selects whether the operation points are to be displayed or not displayed.
The non-displayed operation points are fixed at the positions when the selection was made not to display them.
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Line Masking

PC-1 LY
Line Masking Bitmap Masking
[+] Enable [+] Enable
Left Upper Right Lower
Invert [Jinvert
@ ©® @ @

@) Left

When a check mark is entered for [¥!Left | masking based on the operation point on the left side of the projected image is
enabled.

@ Upper

When a check mark is entered for [¥| Upper | masking based on the operation point at the top of the projected image is
enabled.

@ Right

When a check mark is entered for ¥|Right ' masking based on the operation point on the right side of the projected image
is enabled.

@ Lower

When a check mark is entered for ¥/ Lower = masking based on the operation point at the bottom of the projected image is
enabled.

@ Invert

When a check mark is entered for |_Invert | the Line Masking area can be inverted between positive and negative.

Upper operation point (Blue)

Right operation point (Green)
Left operation point (Red)

Lower operation point (Orange)

The operation points at both ends of a side can be moved around the outer circumference (along the four sides) of the
image.

When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line
that connects the operation points at both ends of the side.

When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.
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Bitmap Masking

PC-1 w
Line Masking Bitmap Magking
[+ Enable [~]Enable
Left Upper Right Lower
|:| Inwert T Invert

@ )

) File
Click this button to open the screen on which to select the bitmap data used for masking.
Using the bitmap data which has been loaded, mouse operations can be used to move, enlarge or reduce the masking
area.
The bitmap data can be moved, enlarged, or reduced in a display area with a resolution of 2880 x 1800 pixels (when the
resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 5760 x 3600 pixels (when the resolution is other
than the aforementioned).

If [File] is clicked when the bitmap data for masking has already been loaded, the previously loaded bitmap data is
discarded and the new loaded bitmap data is set for masking.

@ Invert

When a check mark is entered for [_|Invert | the Bitmap Masking area can be inverted between positive and negative.

Bitmap data (example)

Drag to move.

. When the center point here is dragged, the masking area
can be enlarged or reduced horizontally or vertically.

When a point in one of the four corners is dragged, the
masking area can be enlarged or reduced without changing
the aspect ratio.
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Input Signal Adjustments

Input Signal Adjustments

Projectors normally identify the input signals automatically, but if unstable signals are to be input, this software application
allows the format matching the input signals to be selected, position adjustments to be made, and so on by manual means.

Input Signal screen

©@

|8 Geometry Manager Pro - O X
File Edit View Tools Version
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@ Input Select
These are used to select the input.

Click the input (selector) button of the signals to be projected.
The inputs that can be selected vary depending on the model. For a model equipped with slots, the buttons are enabled
only for the slots with boards inserted, and the inputs that can be selected are displayed on the buttons.

Input Select
sDER2 SDI3 SDi4
HDMH [Slat1] HDMI2 [Siot1] [Slot1 [Slot1
[Siot2] [Slotz] SDI3 [Slot2] SDI4 [Siot2]
Digital Link

This operation is reflected in the projector even if a check mark has not been entered for ("] Auto Transfer.
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Input Signal Adjustments

@ System Selector

The system format which matches the input signals is selected here.
The formats which can be selected differ depending on the projector model, input signals and input connectors.

Input Select

System Selector

RGB1, Y/C or
RGBH1, Y/C, Video

When [RGB/YPbPr] is selected*!

When [Y/C] or [Video] is selected*"

RGB / VGAB0
YCbCr / YPbPr / 480p YCbCr
480p RGB

RGB / 640x480/60p

YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PALG0O

RGB2

RGB / VGAG0
YCbCr / YPbPr / 480p YCbCr
480p RGB

RGB / 640x480/60p

YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

Video

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PALG0

DVI-D

RGB
YCbCr/ YPbPr

HDMI

Auto
RGB
YCbCr/ YPbPr

Digital Link

Auto
RGB
YCbCr/ YPbPr

75




Adjustment and Settings

Input Signal Adjustments

1080/50i YPbPr
1080/60i YPbPr
1080/50p YPbPr
1080/60p YPbPr
1080/24p RGB
1080/24sF RGB
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB

1080/60i RGB
1080/50p RGB
1080/60p RGB
1080/50p YPbPr
1080/60p YPbPr
2K/48p RGB
2K/50p RGB
2K/60p RGB
2K/48p YPbPr
2K/50p YPbPr
2K/60p YPbPr

Input Select System Selector
SDI1 or SDI When [Single Link] is selected*? When [Dual Link] is selected*? When [Auto] is selected*?
Auto Auto Auto
480i YCbCr 1080/24p RGB
480/60i YCbCr 2K/24p RGB
576i YCbCr 2K/24p XYZ
576/50i YCbCr 1080/24sF RGB
720/50p YPbPr 2K/24sF RGB
720/60p YPbPr 2K/24sF XYZ
1035/60i YPbPr 1080/25p RGB
1080/24p YPbPr 1080/30p RGB
1080/24sF YPbPr 1080/50i RGB
1080/25p YPbPr 1080/60i RGB
1080/30p YPbPr 1080/50p RGB
1080/50i YPbPr 1080/60p RGB
1080/60i YPbPr 1080/50p YPbPr
1080/50p YPbPr 1080/60p YPbPr
1080/60p YPbPr 2K/48p RGB
1080/24p RGB 2K/50p RGB
1080/24sF RGB 2K/60p RGB
1080/25p RGB 2K/48p YPbPr
1080/30p RGB 2K/50p YPbPr
1080/50i RGB 2K/60p YPbPr
1080/60i RGB
2K/24p RGB
2K/25p RGB
2K/30p RGB
2K/48p RGB
2K/50p RGB
2K/60p RGB
SDI2 When [Single Link] is selected*? When [Dual Link] is selected*? When [Auto] is selected*?
Auto Auto Auto
480i YCbCr 1080/24p RGB
576i YCbCr 2K/24p RGB
720/50p YPbPr 2K/24p XYZ
720/60p YPbPr 1080/24sF RGB
1035/60i YPbPr 2K/24sF RGB
1080/24p YPbPr 2K/24sF XYZ
1080/24sF YPbPr 1080/25p RGB
1080/25p YPbPr 1080/30p RGB
1080/30p YPbPr 1080/50i RGB

*11n the Other screen, select with [Display Option] - [RGB In] - [RGB1 Input Setting].
*2 |n the Other screen, select with [Display Option] - [SDI In] - [SDI Link].
&= “Display Option” (page 81)

® For models that do not support dual link HD-SDI signals, the system format that can be selected when [SDI1], [SDI],
or [SDI2] is selected with [Input Select] is the same as for [Single Link].
® Even if an [Input Select] button shown in the table above is selected, the function may be disabled depending on the
projector you are using.
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€)

Aspect
The aspect ratio of the images is selected here. The aspect ratios that can be selected are listed below:

® Default/ Auto / VID Auto
® Through

® 16:9

® 4:3

® HFIT

e VFIT

® HVFIT

For details, refer to the operating instructions of the projectors.

Clock Phase

Image flickering and contour blurring are adjusted here.

Input value range: 0 to 31

However, they cannot be adjusted when Y/C signals have been selected as the input signals.
For details, refer to the operating instructions of the projectors.

Zoom Mode

The zoom mode is selected here.

The setting is enabled when [Default / Auto / VID Auto] has been selected as the Aspect setting.
The modes that can be selected are listed below:

® Internal
® Full

For details, refer to the operating instructions of the projectors.

Vertical (Zoom)
The zoom magnification in the vertical direction is set here.
Input value range: 50 to 999

Horizontal (Zoom)
The zoom magnification in the horizontal direction is set here.
Input value range: 50 to 999

Interlocked
When a check mark is entered for [¥]nterlocked | the same zoom magnification can be set in both the horizontal and
vertical directions.

Vertical (Shift)
The vertical position of the projected image is set here.
The input value range varies depending on the projector model.

Horizontal (Shift)
The horizontal position of the projected image is set here.
The input value range varies depending on the projector model.

The Input Signal screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Menu Settings

Some of the operations using the projector's menus can be performed using this software application.

Other screen

® @ ® ® 6
|l Geometry Manager Pro — O %
File Edit View Tools Version
= = ‘ ‘ = | = | (| ] i@ Auto AniusT B
* ¢ L | Geol E(ryl Edge Bles mg‘ Uniformity} Brightness \Jn(rull CulurMa(chlngl F.|ask|ng| \npu(Slgnall Other
.

0z PROJECTORZ (0.0.0.2)
03 PROJECTORZ (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
0s PROJECTORS (0.0.0.5) Standard ~
06 PROJECTORE (0.0.0.8)
o7 PROJECTORT (0.0.0.7)

I Picture IAdvan:ed Wenu l Display Option I Projector Selupl PinP ||

Picture Mode Color Temperature Gamma

Default ~ Rename Default ~ Rename

‘White Balance Red High 255

Contrast o = = System Daylight View OFF ~
08 PROJECTORS (0.0.0.8) . o
S 3 = White Balance Green High 255~ Dynamic Contrast
Add Del Rename g - — =
White Balance Blue High 255 2 OFF v
Display Projector Name Color 0 =
= hite Balance Red Low 2 ArEnEe OFF
Power ON Standby Tint 0 =
= White Balance Green Low 2 Bright Signal Level -
Shutter Close Shutter Open Sharpness 0 2
e Belance Blue L. o Lights Out Timer Disable
05D ON 05D OFF Noise Reduction OFF v fihite Salanes Slus Low o —
Lights Out Signal Level =
Status ON Status OFF Waveform Monitor
Status Page | Prev Next OFF - Manual Intensity 0
Test Pattern N 5 Dynamic Gamma OFF
Line Posttion 0 =
OFF -
Color Space Native v
Grid Resolution
11 ~| x [ -
[]use square Grid
Display Grid Lines
OFF v
Cursor Information
Display Cursor
Coordinate Information
None
Absolute
Relative
Transfer
Wanual Transfer v
[ Auto Transfer i >
x1/4

@ Picture

Click to display the Picture screen.
The video mode, black level and other settings related to the image adjustments can be selected.

@ Advanced Menu
Click to display the Advanced Menu screen.
The blanking width, input resolution and other settings can be selected.

@ Display Option
Click to display the Display Option screen.
The color correction, aspect ratio and other settings related to the image display used for large screens can be selected.

@ Projector Setup
Click to display the Projector Setup screen.
The projector’s projection system, lamp selection and other hardware settings can be established.

@ The items displayed will vary depending on the projector you are using.
PinP
Click to display the P in P screen.
The positions and sequence of priority for the main screen and sub screens as well as other P in P functions can be set.
Multi Display
The inputs for 4-split display, frame lock, and other settings for the multi screen function can be set.
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H Picture

Picture  Advanced Menu | Display Option ijactanetup| PinP

Picture Mode Color Temperature.

Standard ~ Rename Default ~

= White Balance Red High
Contrast o =

= White Balance Green High
Brightness o =

= White Balance Blue High
Color o =

= White Balance Red Low
Tint o =

- White Balance Green Low
Sharpness o =

Whi

Noise Reduction oFF - White Balance Blue Low
‘Waveform Monitor
OFF v

Line Position

The following items can be set:

Gamma

Rename Default v Rename

= System Daylight View OFF ~
: Dynamic Contrast

O OFF v

o Auto Contrast OFF

= Eright Signal Level =

- Lights Out Timer Dizable

Lights Out Signal Level
Manual Intensity ]

Dynamic Gamma OFF

Color Space Native v

Picture Mode **

Contrast

Brightness

Color

Tint

Sharpness

Noise Reduction

Waveform Monitor
Line Position

Color Temperature
White Balance Red High
White Balance Green High
White Balance Blue High
White Balance Red Low
White Balance Green Low
White Balance Blue Low

Gamma

System Daylight View

Dynamic Iris
Auto Iris
Manual Iris
Dynamic Gamma

Dynamic Contrast
Auto Contrast
Bright Signal Level
Lights Out Timer
Lights Out Signal Level
Manual Intensity
Dynamic Gamma

Al

White Gain

Color Space

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.

® Items marked ** are reflected in the projector even when a check mark has not been entered in || Auto Transfer.
® The Picture screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon

menu.
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H Advanced Menu

The following items can be set:

Picture |[ Advanced Menu  Display Option | Proj wp | Pinp

Digital Cinema Realty | Auto

Blanking
Upper

Input Resolution

Total Dots E =)
Display Dots E 2
Total Lines @ =
Display Lines @ =

jector Set
~

Clamp Position 24 =

Frame Respense Normal

Frame Creation

Frame Creation Mode | OFF

Film Detection OFF

Raster Postion

Vertical

Digital Cinema Reality
Blanking
Upper
Left
Right
Lower
Input Resolution
Total Dots
Display Dots
Total Lines
Display Lines
Clamp Position
Frame Response
Frame Delay
Frame Creation
Frame Creation Mode
Film Detection
Frame Lock
Raster Position
Vertical
Horizontal
Quad Pixel Drive

B
Harizontal 0 =

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

The Advanced Menu screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and

icon menu.
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m Display Option

Picture | Advanced Wenu || Display Option Projector Setup | Pin P

i Shutter Setting 501
Large Screen Correction OFF ~ D
Mechanical Shutter i i
Screen Setting SDI Link Single ~
Fade-in OFF v
Screen Format 16:10 ~ T T
= = Fade-Out oFF o arget Input Single:S0I1 ~
Vertical Position 0 = .
2 Startup Open - Resolution Auto ~
Horizontal Posttion 0 =
Shut-Off Open v
3G-50I Mappin: v
[ Auto Signal ons Disp = Auta
Auto Setup TR S System Selector Auto -
0SD Posttion 2 v
Mode Default ~
Display Dots 1024 > Bit Depth Auto ~
05D Rotation OFF v
Position Adjust F— Signal Level £4-940 ~
[ signal Level Adjust ecute 0SD Design 1 v
SO M
Background Color Blue ~ el:nnry
nput Guide Digital Link In
- varning Message
Startup Logo Default Logo Signal Level rm -
Cut Off
[Jred [ Green e
EDID Mode Default ~
Image Rotation OFF o

EDID Resolution/\V Scan Freg

RGB In
RGB1 Input Setting RGB/YPbPr A
Backup Input Setting RGB1 Sync Slice Level High ~
Backlp R o 27F ~|  RGB2 Sync Sice Level High -
Automatic Switching
Simul Input Setting RGBZ EDID Mode Default ~
RGB1/RGB2Z OFF ~
RGB2 EDID Resolution
HOMVDVI-D OFF v
RGB2 EDID V Scan Freq.
SDi/sD OFF ~
DVIDIn
DVI Signal Level 0-255:PC v
DVIEDID Select EDID3 ~
DV EDID Mode Default ~
DVI EDID Resolution 1920x1200p
DVI EDID V Scan Freq 60Hz
HDMIIn
HDMI Signal Level 0-1023 ~
HDMI EDID Mode Default v

HDMI EDID Resolution

HDMI EDID V Scan Freq.
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Projector Menu Settings

The settings of the items listed below can be established and operated.

Large Screen Correction
Screen Setting
Screen Format
Vertical Position *
Horizontal Position *
Auto Signal
Auto Setup
Mode
Display Dots *
Position Adjust
Signal Level Adjust
Execute
Background Color
Startup Logo
Cut Off
Red
Green
Blue
Image Rotation
Closed Caption Setting
Shutter Setting
Mechanical Shutter
Fade-In
Fade-Out
Startup
Shut-Off
On-Screen Display
OSD Position
OSD Size
OSD Rotation
OSD Design
OSD Memory
Input Guide
Warning Message

Color Correction
Red
Green
Blue
Cyan
Magenta
Yellow
Backup Input Setting
Backup Input Mode
Automatic Switching
Simul Input Setting
RGB1/RGB2
HDMI/DVI-D
SDI1/SDI2
SDI In
Slot In
SDI In
SDI Link
SDI1 Signal Level
SDI1 Bit Depth
SDI1 3G-SDI Mapping
SDI2 Signal Level
SDI2 Bit Depth
SDI2 3G-SDI Mapping
Dual Link Signal Level
Dual Link Bit Depth
Dual Link 3G-SDI Mapping
Target Input
(The selection options of the
following adjustment items

vary depending on the selected

setting.)
Resolution

4K Division
3G-SDI Mapping
System Selector
Color Space
Sampling

Bit Depth

Signal Level

Digital Link In
Digital Link Signal Level
Digital Link EDID Select
Digital Link EDID Mode
Digital Link EDID Resolution
Digital Link EDID V Scan Freq.
Signal Level
EDID Select
EDID Mode
EDID Resolution/V Scan Freq.
RGB In
RGB1 Input Setting
RGB1 Sync Slice Level
RGB2 Sync Slice Level
RGB2 EDID Select
RGB2 EDID Mode
RGB2 EDID Resolution
RGB2 EDID V Scan Freq.
DVI-D In
DVI EDID
DVI Signal Level
DVI EDID Select
DVI EDID Mode
DVI EDID Resolution
DVI EDID V Scan Freq.
HDMI In
HDMI Signal Level
HDMI EDID Select
HDMI EDID Mode
HDMI EDID Resolution
HDMI EDID V Scan Freq.
Slot In
Link Select **
Link Setting ***
EDID Setting ***

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.

® Items marked with an asterisk (*) cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and

icon menu.

® Items marked ** are switched automatically depending on whether a board is inserted in the slot and the type of board if a

board is inserted.

® Items marked *** are switched automatically depending on setting of Link Select.
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B Projector Setup

Picture | Advanced Menu | Display Option || Projector Setup PinP

Projection Method Front / Floor ~ Standby Mode Normal ~

Cooling Condition Floor Setting ~

Lamp Select

Dual - Apply No Signal Shut-Off Disable ~

Lamp failed

Initial Startup Last Memory e

Lamp Relay
Startup Input Select Last Used v
OFF -

Date and Time

Lo prrme Eco 27 Time Zone +09:00 v

Synchronize to PC

The settings of the items listed below can be established and operated.

Projection Method
Cooling Condition
High Altitude Mode
Lamp Select *
Lamp Relay
Time
Standby Mode
Quick Startup
Valid Period
No Signal Shut-Off
No Signal Lights-Off
Initial Startup
Startup Input Select
AC Voltage Monitor
Date and Time
Time Zone *
Synchronize to PC **
(The projector’s clock setting is synchronized with the computer.)
Multi Projector Sync
Mode
Contrast Sync
Shutter Sync

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

® Items marked with an asterisk (*) cannot be reset using the [New All Data] and [New Data (For Current Window)] commands
on the File submenu and icon menu.
® tems marked ** are reflected in the projector even when a check mark has not been entered in || Auto Transfer.
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Projector Menu Settings

mPinP

The following items can be set:

Picture | Advanced Menu | Display Option ProjectorSetup| PinpP

Pin P Mode Userl ~

Frame Lock Wain Window ~

Type Sub Window i

Main Window Sub Window

Input Signal RGB1 ~ Input Signal HOMI
Size Size
Interlocked Interlocked
Vertical 100 = Vertical 3 =
Horizontal 100 2 Horizontal 3 2
Position Position
Vertical 0 = Vertical 0 =
Horizontal 0 = Horizontal 0 =

Clock Phase 0 s

P in P Mode **
Frame Lock
Type
Main Window
Input Signal
Size
Interlocked
Vertical
Horizontal
Position
Vertical
Horizontal

Sub Window
Input Signal
Size

Interlocked
Vertical
Horizontal
Position
Vertical
Horizontal
Clock Phase

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

® Items marked ** are reflected in the projector even when a check mark has not been entered in [ | Auto Transfer.
® The P in P screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon

menu.
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® Multi Display

Picture | Advanced Menu | Display Option Prn]ectanelup‘ Wult Display

Mutli Display Mode User v
Frame Lock Upper Left Window ~
Upper Left Window SDH ~ Upper Right Window sDE2 -
Lower Left Window SDI3. ~ Lower Right Window SDI4 ~

The following items can be set:

Multi Display Mode **
Frame Lock

Upper Left Window
Lower Left Window
Upper Right Window
Lower Right Window

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

® tems marked ** are reflected in the projector even when a check mark has not been entered in || Auto Transfer.
® The Multi Display screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Control

Control commands can be sent to the projector.

Command Control screen

@

©

A Command Control x

01 PROJECTOR1 (0.0.0.1) PT-RZ21  [|5end Command
02 PROJECTOR2 (0.0.0.2) PT-RZ21K I|QIN [I] Send ||
03 PROJECTOR3 (0.0.0.3) PT-RZ21K
04 PROJECTOR4 (0.0.0.4) PTRZ21K

05 PROJECTORS (0.0.0.5) FTRZZIK Function | Edit }—@
06 PROJECTORE (0.0.0.6) PFT-RZZ21K
07 PROJECTORY (0.0.0.7) PT-RZZ1K Frame Creation OFF Function & Function 11
08 PROJECTORS8 (0.0.0.8) PT-RZ2IK
Frame Creation MAX Function 7 Function 12
Function 3 Function 8 Function 13 ——@
Dynamic Contrast OFF Function @ Function 14
® h— Dynamic Contrast USER Function 10 Function 15

Command Log

Time (Local) - Destination Send Receive
2017-07-03 11:32:14.375 PROJECTORS VXXGFRCI1=+00003 VIX:FRCI1=+00003
2017-07-03 11:32:21.361 PROJECTOR1 QAL:D QALD

20170703 11:32:21.361 PROJECTOR2 QAL:D QAL

2017-07-03 11:32:21.361 PROJECTOR3 QAT:D OAL:0

2017-07-03 11:32:21.361 PROJECTOR4 QAL:D QAL

2017-07-03 11:32:26.570 PROJECTORS QIM HD1

Projector list

Displays a list of the numbers, projector names, IP addresses, and model numbers of the connected projectors.

The selected projector is the target for sending the command. The control command send target can be switched by
selecting a projector in the list.

® Multiple projectors can be selected by holding down the Ctrl key while clicking.

Command input
Enter the control command to send.

Send command
Send the entered control command to the selected projector.

Edit registered commands

Up to 15 frequently used commands can be registered. Clicking opens the Edit screen.

Only a button with a command registered can be clicked.

The text to display on the button can also be edited in the Edit screen. If the text to display on the button is not edited, the
default text ("Function*" where * is the number of the button) is displayed.

Send registered commands
Sends the registered commands to the selected projector.

Command Log

Displays the communication log for sent commands. This displays four information items: send time, send destination
projector name, sent command, and response to sent command.

Each information item can be sorted in ascending and descending order.

The maximum number of logs that can be displayed is 2,048.

Clear command log
Clear the information displayed in the command log.
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Close

Close this screen. The command log is also cleared when the screen is closed.

Edit screen

Edit »
Tije Comnfand

Function 1 |Frame Creation OFF VXX:FRCI1=-+00000] Clear
Functien2  ||Frame Creation Max VXGFRCL1=-+00003 oo
Function 3 | o
Function 4 |Dynamic Contrast OFF OALD Clear
Function 5 |Dynamic Contrast USER 0AT:4 o
Function & | =
Function 7 | =
Function 8 | e
Function 9 | Conr
Function 10 | o
Function 11 —
Function 12 | =
Function 13 | =
Function 14 | =
Function 15 | =

l Confirm lll Cancel ||

@ Title

Enter the text to display on the registered command send buttons in the Command Control screen.
The text can consist of a maximum of 32 characters including letters, numbers, and symbols.
When there is no input in Command, the text entered here will not be reflected in the Command Control screen.

Command
Enter the control commands to register.

Clear
Clear both the registered command name and registered command.

Confirm
Confirm the current editing information.

@ ® © ©

Cancel
Discard the current editing information. A screen appears to confirm whether or not discarding the information is a
problem.
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Auto Screen Adjustment

Applying the ET-CUK10/CUK10P Auto Screen Adjustment upgrade kit to the projector expands the functions of “Geometry
Manager Pro”, and allows automatic adjustment of geometry correction, edge blending, color and brightness correction,
adjustment of white balance, and adjustment of black level according to the shape of the screen through use of an externally
connected camera.

After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

® The Auto Screen Adjustment upgrade kit is required to enable the Auto Screen Adjustment function.

Product Number Product Name Description
ET-CUK10 Auto Screen Adjustment | Activating on each projector enables the “Auto Screen Adjustment plug-in software”
Upgrade Kit functions.
ET-CUK10P Auto Screen Adjustment | Activating on a computer on which the software is installed enables the “Auto Screen
Upgrade Kit (PC) Adjustment plug-in software” functions.

&= “Activation” (page 12)

® You can check whether the “Auto Screen Adjustment plug-in software” is installed and the activation status of the Auto
Screen Adjustment upgrade kit (PC) in [About Geometry...] of the Version submenu.

® To use the Auto Screen Adjustment function, prepare a camera separately.

Preparing Auto Screen Adjustment

B Projector connection

Use a LAN cable to connect the projector to the computer.

H Camera connection

Use a USB cable to connect the camera to the computer.
For details on compatible cameras, check the information found on the software download page after logging in to PASS on
the Panasonic website (https://panasonic.net/cns/projector/pass/).

B Connection example

Projectors

LAN
connection
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Auto Screen Adjustment Compatible screens for Auto Screen Adjustment

@ Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment
results. Adjustment is possible when the camera is facing the screen at an angle but may fail if the angle is too large.
® In cases such as the following, adjustment is possible using multiple cameras (up to 6).
- When the projector layout configuration has 5 or more projectors in the vertical or horizontal direction.
- When the entire screen does not fit in the capture range of 1 camera.
However, black level adjustment is only possible using 1 camera.

Compatible screens for Auto Screen Adjustment

Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed
properly, perform adjustments manually.

Compatible screens Non-compatible screens

® Flat ® Folded

Folded screen type

® Curved screen . ) )
* Individual adjustments for each side are

Curved in one direction Curved in two directions

® Curve changes smoothly

] ]

S-curve Variable curve type
® 360-degree curved screen
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Auto Screen Adjustment Operation flow for Auto Screen Adjustment

Operation flow for Auto Screen Adjustment

Settings for Auto Screen Adjustment are configured in a wizard format.

Adjustment items selection

E—
Projector Layout

Projector layout settings
v
Projector selection and positioning

=
Camera Setting

|: Camera connection and layout :|

v
Camera settings

e
Projection Setting

Geometry . ]
[ Edge Blending ] [ Color Matching J [ White Balance ] [ Black Level ]

=

’ Auto Screen Adjustment complete l
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Auto Screen Adjustment

Auto Screen Adjustment procedure

Auto Screen Adjustment procedure

Starting Auto Screen Adjustment and selecting the adj

1 Click the [AUTO ADJUST] button in the main screen.

ustment item

O

*

I [FEEEEH] @ AuTo ADJUST

ﬂ Culurr.‘atc:hing| r.|asking| InputSignaI| 0ther|

2 Click the items you want to adjust.

B Auto Screen Adjustment

Click the buttan yeu want b adjust.

Calor Matching

Edge Blending

Color Matching

White Balance

Dlack Level

Adjustment items selection screen

® You can select from following five options
- [Geometry, Edge Blending, Color Matching]
- [Geometry, Edge Blending]
- [Color Matching]
- [White Balance]
- [Black Level]

By clicking the [Re-adjust] button to the right of each option, you can restore it to the setting that it had previously.

& “Readjust by recalling previous settings” (page 92)

® The subsequent steps and screens that appear in the procedure will vary depending on the selected items.

® Make sure the projector is turned on before starting Auto Screen Adjustment. Proper correction will not be possible if the

projector is in the standby state.
® \When performing automatic screen color, brightness, white balance, and
where the impact from external lighting will be low.

black level correction, do so in an environment

® While setting Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to

check which step you are currently performing.

Progress indicator

aﬁ Auto Screen Adjustment

Projector Layout

p——

Camera Setting Projection Setting
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Auto Screen Adjustment Auto Screen Adjustment procedure

B Readjust by recalling previous settings

By clicking the [Re-adjust] button, you can restore options to the settings that they had previously.

B Auto Screen Adjustment ="

Click the bufton you want to adust.

'
Color Maiching
S Cha0TaEy I e Mo He-adjust
S

@ If an option does not have a previous setting, the [Re-adjust] button for that option is disabled.

@ If readjustment fails, Auto Screen Adjustment is canceled. In this case, you can continue making adjustments using the
usual manual procedure from the point at which adjustment was interrupted.

® To cancel Auto Screen Adjustment in progress, click [Abort]. In this case, you can continue making adjustments manually
from the point at which adjustment was interrupted.
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Auto Screen Adjustment Auto Screen Adjustment procedure

Projector Layout

1 Specify the projector configuration in the projector layout setting screen.

B Auto Scrcen Adjustment x

[Restore]

Reszre

Layout information display area

[Height / Width / Stack]

Cick Next o contrne.

Projector layout setting screen

1) When you click the [Restore] button and layout information from previously configured projectors exists, the layout
information is loaded and applied to the layout information display area.
2) Enter the height, width, and stack layout for the projectors in the [Height / Width / Stack] fields.
® Up to 99 projectors can be configured.
- In the case of 1 camera, adjustment can be performed for up to 4 vertically, up to 4 horizontally, and up to 6
stacked.
- 5 or more projectors can be configured either vertically or horizontally by using multiple cameras. In such cases,
the relationship between the number of projectors and the number of cameras is as follows.
Number of projectors 1to 4 3to7 41010 51013 6to 16 71019
Number of cameras 1 2 3 4 5 6

- 360-degree curved screens require 5 or more projectors in the vertical or horizontal direction and 3 or more

cameras.
Number of projectors 5t09 5t0 12 5t0 15 61to 18
Number of cameras 3 4 5 6

® You cannot configure a layout that includes more projectors than the total number of connected projectors.
® If [Geometry, Edge Blending, Color Matching], [Color Matching], [White Balance], or [Black Level] was selected in the

adjustment items selection screen, configure the layout so that either height (vertical) or width (horizontal) is more than
one projector.

3) Click [Next].
® To return to the previous screen, click [Back].

93



Auto Screen Adjustment Auto Screen Adjustment procedure

2 Select the projectors for which to perform correction in the projector selection screen.

| & Aure Sereen Adjusment X

Select the projectors b use for suto sdustment

1P Address: Model A
0.0.0.1 PTOZ2IK
0002 PTOZ2IKZ
0003 TN
0004 Tz
0005 PTozIKE
00,06 PTOTIN2
0007 PTozaKE
PTozINE
PTozaN:
Prozame

Check boxes

JEOREEITTORREEE

Number of ——
selected

i || o e [Clear Alll]

ik Mt to contre.

projectors [Select All]

Projector selection screen

1) Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
® You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking
the [Clear All] button.

@ If you clicked the [Restore] button in step 1 to load previous layout information, the check boxes for the configured
projectors will be selected.

® |f * is displayed on the left of a projector name, you cannot select that projector for auto screen adjustment.

® Apply the Auto Screen Adjustment upgrade kit (ET-CUK10) to the projectors or apply the Auto Screen Adjustment
upgrade kit (PC) (ET-CUK10P) to the computer.
&= “Activation” (page 12)

2) Click [Next].
® To return to the previous screen, click [Back].
® When [Color Matching] and [White Balance] are selected, a warning message will appear if projectors of different
models coexist. Click [Next] to continue the process, or click [Cancel] to reselect projectors.
® An error message will appear in the following cases.
In such cases, click [OK] and select the projectors again.
- Projectors with different resolutions coexist when [Geometry, Edge Blending, Color Matching], [Geometry, Edge
Blending] or [Black Level] is selected.
- The number of selected projectors does not match the number of projectors configured in the projector layout
setting screen in step 1.

- When the Auto Screen Adjustment upgrade kit (ET-CUK10/ET-CUK10P) is not applied to either the selected

projectors or computer.

When you click [Next], the geometry correction, edge blending, color/brightness correction, and white balance adjustment
of the projectors will be initialized.
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3 Confirm projector positioning in the projector positioning screen.

1)

2)

B Auto Screen Adiustment *
amera Setng

L Find the projected number en the sareen.
2. Click the location of the projected number on the layout chart below
. Locate every projected rumber untl o of them are placed correctly on the layout chart.

Selected projectors

] 4
5 PRONCTORS
PRGIECTORS
PROJECTORS
PROJECTORI0
PROJECTORLL
0 FROECTOR1Z
1 PROIECTORIY
2 PROIECTORIS

[Undo]

[Reset]

sy ———[Identify]

Chek et 1 contrue,

Projector positioning screen

Click the layout window to position the projectors.

® Configure the projectors in order, starting with the first projector in the list of selected projectors. Each number will
be projected on the screen. Position the projectors in the layout window so that their numbers match the projected
numbers.

® Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.

® You can cancel the positioning of the projector currently being configured by clicking the [Undo] button, or cancel
positioning for all projectors by clicking the [Reset] button.

Click [Next].

® To save the projector positioning information, click [Next].

® To return to the previous screen, click [Back].

® An error message will appear if positioning of all the projectors is not complete. Configure settings again.

@ If other than [Black Level] is selected, go to the camera connection screen.
@ “Camera Setting” (page 96)

4 Select the storage location of the current geometry correction data in the geometry correction data storage
location confirmation screen.

B Auto Screen Adjustent *

Smeciue Lmk ey s Ay

Because Geametry satting is need to set bs OFF bemporarly, plesse select the stursge bzation of Geometry sdjustment dot, The kacation s comman to
al projectors
1f youidan

@rc1  Orcz ORI Oameedmsise

ek tiawt 0 comtre, P

1) The current geometry correction data needs to be stored inside the projector so select that storage location from [PC-

1] to [PC-3]. If the data is already stored, select [No need to store].

® The storage location is common for all projectors that are target for Auto Screen Adjustment.

® |f the current geometry correction data is not stored, that data will be discarded during the process. The result of
black level adjustment will not be able to be guaranteed.
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2) Click [Next].
® When [Next] is clicked, the current geometry correction data is saved to the storage location.
® To return to the previous screen, click [Back].

Camera Setting

1 Verify camera connection in the camera connection screen.

8 Auto Screen Adjustivent *

Cick Seerch Camera and select the camera to use.

[Search Camera] 1 D v

4 Jcareras D50
=] 0530
Camera 3 osmo

Check boxes

i | et e [Clear All]

If fiabed to search camere, pesve chack the Folowg. [Select A"]

13 the camern connacted cormectly?)

- 15 the camecn poweron 7

Chk Hext 1o contrue,

Camera connection screen

1) Click the [Search Camera] button.
® The model names of the detected cameras are listed.
@ If a camera is not displayed in the list, check the following.
- The camera is properly connected
- The camera is turned on
® \erify that the check boxes of the cameras to be used are selected.
® You can select all the cameras by clicking the [Select All] button, or clear selection of all the cameras by clicking
the [Clear All] button.
2) Click [Next].
® To return to the previous screen, click [Back].
® |f [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected and the layout is configured
so that either height (vertical) or width (horizontal) is more than one projector in the projector layout screen, the
black level adjustment selection screen opens.

| & Auto Screen Adjustment X

) Acust using the camers. (3 enrcrment & necessary.)

Select the process for the black level of the area to be overlapped.

- [Set temporary value]: Overwrite the black level value with the temporary value of the corresponding models.
- [Use current settings]: Retain the current (pre-adjustment) black level value.

- [Adjust using the camera]: Adjust the black level using the camera.
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® \When there are 2 or more cameras, goes to "2 Camera layout screen."
® \When there is one camera, goes to "3 Camera setting screen.”

@ If there are two or more cameras, [Adjust using the camera] cannot be selected.
Click [Next].
® If [Black Level] is selected, an error occurs when two or more cameras are selected.

2 Decide the layout (arrangement) of the cameras while checking the captured images in the camera layout screen.

Perform this work when using 2 or more cameras.

B Auto Screen Adjustment X

[Restore]

Camera layout

o Tetsot

0 s f i s L [Test Shot]

l ————Camera target ranges
Camera selection

Captured image
display window

Camera —
layout window
(orange frame)

Next

Camera setting screen
1) Set the camera layout.
® [Horizontal / Vertical]: Camera placement direction (horizontal/vertical)
® [360 degree screen]: Select this check box when 360-degree screen
2) Select the cameras and set the target ranges.
® The target range of the selected camera is indicated by an orange frame in the camera layout window.
3) Capture a test shot with the camera.
® When you click the [Test Shot] button, a test shot is captured with the selected camera and the captured image
appears in the captured image display window.
® \erify that the target range fits within the captured image.
If it does not fit, check the actual position of the camera, the selection status of the camera, and the target range
setting.
4) Click [Next].

® The layout settings of the camera may not be able to be changed depending on the conditions.
@® One projector's worth of overlap is required for images captured with cameras that are side by side.
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3 Configure the camera you will use in the camera setting screen.

B Auto Screen Adustment x

E‘ ikl TR ik

Camera Setp,

Clck Auita Setup and check the previem inage.

[Auto Setup]  E—T—

Comern ) wite

[Manual Setup] ———{=sx=

Whie Baiance:

Shutter Speed

[White Balance / Image display window

Shutter Speed / b
ISO / F-number]

s e[ Test Shot]

ik Next to conrue.

Camera setting screen

1) Click the [Auto Setup] button.
® A test pattern appears on the screen, and camera configuration starts automatically.
® \When using 2 or more cameras, configure the settings of all the cameras.
® The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.
You can select the [Manual Setup] check box to configure the setting values manually.
@ If [Black Level] is selected, next also set the camera for black level adjustment.
2) Capture a test shot.
® A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display
window. Verify that the entire screen fits within the image display window.

@ To obtain the optimal adjustment results, make adjustments so that the target area of the screen fills as much of the
captured image display window as possible.

® Adjustment may fail if the target area of the screen does not fit properly within the captured image display window.

® An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and
configure settings again.

® If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

3) Click [Next].
@ To return to the previous screen, click [Back].
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Auto Screen Adjustment Auto Screen Adjustment procedure

Projection Setting

Adjust the option selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91).
Perform the operations by referring to their explanations on the following pages.

® When [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected
& “Geometry and Edge Blending Adjustments” (page 99)
® When “Color Matching” is selected
& “Color Matching Adjustments” (page 105)
® When “White Balance” is selected
& “White Balance Adjustments” (page 108)
® When “Black Leve” is selected
&= “Black Level Adjustments” (page 111)

B Geometry and Edge Blending Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Next].

When you click [Next], the projector settings will change to those displayed on this screen.
® To return to the previous screen, click [Back].

& Auto Screen Adjusment X

NOTICE: Geometry + Edge Blending adiustment vl begin so0n.

the auto sustmant & wesking

~The follorsng profector settings vl be vet in advance.

Prbse Gamma =23

ik Mext o contre.

=

Setting initialization confirmation screen
(geometry correction and edge blending: when black level correction not performed)

| & Auto Sereen Adjustment ®

NOTICE: Geometry + Edge Slendng adyatment vl begin so0n.

130 nok cperate the than the s s erierg
“The foflowg prfesior seltings v be set n advance.

Picture G -22

Oyname i Dynamic Contrast ¥

M Projector Sync. Made -cee

- A dark vy ommen i requred while the suto sdpstmit i merking. g ot change the brightness of the surroundengs.

ik Next 1o continve,

b

Setting initialization confirmation screen
(geometry correction and edge blending: when black level correction performed)
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2 Configure the screen type and overlap areas in the screen setting screen.

1)

2)

3)

Screen type Number of cursors

B Auto Screen Adiustment x

5. Seiect the screen type et thllrumbes of cross cusors.

e o el sy o e e ech camcly i, [Reset]
i
4. Configure the margn seteng ifinecessary.

ot

_— Mmm — : wwe wmw  —][the last / the second last /
“;':1;"” the third last]
[Restore]

N PO ——[Edge Blending Width]

Cursor

Screen setting window

Chek Start 1 begn Geometry + Crige Biandng adustment

Screen setting screen

Specify the screen type and number of cursors.

® Select the screen type that matches the shape of the screen. If [Horizontal Curve], [Vertical Curve] or [H-V Curve]
is selected, specify the number of cursors according to the curvature of the screen.

[4 Corner]: Flat screen

[Horizontal Curve]: Screen that is curved in the horizontal direction
[Vertical Curve]: Screen that is curved in the vertical direction

[H-V Curve]: Screen that is curved in the horizontal or vertical direction

® When [Cylindrical-H] or [Cylindrical-V] is selected, you can specify 3 to 100 cursors for each side.

When [H-V Curve] is selected, you can specify at 3 or more cursors per side, for a total of up to 300 cursors.

While viewing the actual screen, position the cursors in the screen setting window according to the shape of the

screen.

® Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard,
pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the
Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.

® You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while
holding the Shift key.

® You can also select cursors using the number keys on the keyboard.

@ If cursor layouts were previously configured, you can restore up to the three most recent cursor layout
configurations using the [Restore] button. Select [the last], [the second last], or [the third last] from the pull-down
menu to select the configuration you want to restore, and click the [Restore] button.

® To return all cursors to their original positions, click [Reset].

® When the screen type is [Horizontal Curve], [Vertical Curve], or [H-V Curve], the maximum number of cursors that
are actually projected on the screen at one time is 100. Up to two digits can be be displayed for numbers on the
screen, and the 100th, 200th, and 300th cursors will be displayed as "0." For example, when you want to select the
101st cursor, press the Tab key while the 100th cursor is selected, or enter "101" using the keyboards number keys.
The cursors that are projected are switched in groups of 100 in different colors. Cursors 1 to 100 are displayed in
yellow, 101 to 200 in orange, and 201 to 300 in magenta.

To configure the horizontal and vertical overlap areas, enter the values in the [Edge Blending Width] fields.

@ You can also use the sliders to specify values.

® A percentage value that corresponds to the configured pixel count appears in the percent display.

@ To configure the overlap areas automatically, place check marks next to || Auto of [Horizontal] and [Vertical]. The
values resulting from automatic configuration appear in a message after adjustment is complete.
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Auto Screen Adjustment Auto Screen Adjustment procedure

3 If the content being projected has margins and you want to set the margin area, select the check box next to
[Enable] by [Margin Setting] in the check screen setting screen.

® Setting a screen margin makes it easier to set the position of cursors when making screen settings.
@ Setting of straight margins is possible. Setting of curved margins is not possible.

B Auto Screen Adjustment *

L Select the screen Uype and the rumber of cross Gsors,

2. Ploce the creaa aursors an the sarcen along the projection arca nade cach camera wiew.
3. Configure the evige biending width,

4 Configure the margn settng f necessary.

sereen Type | oraonta Curve o] oo Cursars Hi [§ S z Reset

Screen setting screen
® The margin setting screen opens.
Select the type for margin with [Margin Type] and then set the margin size as a numeric value.

8 Auto Screen Adjustent *

Margin type
Configure the margn settng Auto Masking
e M ' —— [Restore]
reset [Reset]
Margin setting—— e [Open]

ik OK o contirue.

Margin setting screen

® Select the margin type.
[Horizontal]: Horizontal margins at the top and bottom of the image
[Vertical]:  Vertical margins at the left and right sides of the image
[Custom]:  Margins other than the above

® To use Auto Masking together with margins, configure [Auto Masking].
[OFF]: Auto Masking is not performed.
[PC-1/PC-2/PC-3]: Auto Masking is enabled.

[Auto Masking] will only be applied if the upgrade kit (ET-UK20) has been applied to the selected projector.
& “Activation” (page 12)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® Specify margins on each side individually. Select either [%] or [pixel] for [Scale] and enter the overall size of the projected
content (including margins) in terms of the percentage or number of pixels. Note that the total margin that can be set on
any given side cannot exceed 60%.
If [pixel] is selected for [Scale], change the numerical value for [Total resolution] according to the overall content size.

%6 5 [2.50%] 03 [0.00%]
120 -2

[10.00%]

elf
30 = :240 5
- [2.50%] [20.00%:]
v: [ 1200 = EC [2.50%] 0+ | [0.00%]

1 lotal resoluton of the content image is required. )

® Click the [Restore] button to restore the margins to the last previously set configuration.
® Click the [Reset] button to return the configured margin size to the initial value (about 5%).
® Click the [Open] button to reads reference image files (files with the extension .bmp or .jpeg).

® When done setting the margins, click [OK].
Display returns to the screen setting screen.
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Auto Screen Adjustment Auto Screen Adjustment procedure

4 Click [Start].
To save the projector positioning information, click [Start].
® A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.
® To return to the previous screen, click [Back].

B Aute Screen Adjustment x

Please mast whie the suto sdpstivent = i progress.
Do not nterfere: with shootng whie camera i3 warking.

It iy take several minates,

) -r.gﬁ. 27 3c¢ clapsed.

® To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

T e

5 When Auto Screen Adjustment is successfully completed, the following message appears.

To save the adjustments in the projector, select [PC-1], [PC-2], or [PC-3] as the storage location, or select [None] if you do
not want to save the settings, and then click [OK]. If you click [Cancel] the adjustments are not saved in the projector.

Auto Screen Adjustment

Adjustment data will be stored in the projector.
Please select the location to be stored.

(®) Mone Orpc-1 (Cpc2 (Cpc-3

Cancel

If [Geometry, Edge Blending] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page
91) and [Set temporary value] or [Use current settings] was selected in the black level adjustment screen (page 96),

Auto Screen Adjustment is complete.

If [Geometry, Edge Blending, Color Matching] was selected in “Starting Auto Screen Adjustment and selecting the
adjustment item” (page 91) and [Set temporary value] or [Use current settings] was selected in the black level

adjustment screen (page 96), go to the procedure of “m Color Matching Adjustments” (page 105)".

In the case of other than the above, go to the procedure of “m Black Level Adjustments” (page 111)".
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Auto Screen Adjustment Auto Screen Adjustment procedure

® A message appears if Auto Screen Adjustment fails. In such cases, check the content of the message, click [OK], and
configure settings again.
To return to the screen from step 2 (& page 100), click [OK].

Auto Screen Adjustment > Auto Screen Adjustment >
e Adjustment failed Adjustment failed
Projected pattern on the RED frame pertion could not be detected The projection area with the RED frame portions on the screen could
correctly. not be adjusted.

Please check the following.

- Does the preview image at the Camera Setup Page contain the whole Please adjust the position of the projection area or the positien of
screen? the cross cursors at the Projection Setting.

- Is a large part of the projected image on the screen? - The RED frame portions should cover the screen properly.

- Is there no bright ambient light on the screen? - The RED cross cursors should overlap with the GREEN cursors.
[2004] [2006]

® Capture a test shot, and verify that the entire screen ® Check the position of the image that is projected on
fits within the image display window. (&= page 98) the screen.

® Verify that a large portion of the projected image to be
adjusted fits within the screen.

® Check that the camera and screen are as close as
possible to directly facing each other.

® When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment >

Do you want to exit aute adjustment?

o e

® The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time
you configure the settings.

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.
& “Adjustment and Settings - Geometry Correction” (page 41)
& “Adjustment and Settings - Edge Blending” (page 55)
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Auto Screen Adjustment Auto Screen Adjustment procedure

m Color Matching Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Start].

When you click [Start], the projector settings will change to those displayed on this screen.
® To return to the previous screen, click [Back].

B Auto Screen Adjustvent *

Projector Layout Camera Scttng

NOTICE: Cokor Motching adjustment vl begin soun,
Do not aperate the prasectors other than thi apokcatin whic the suto adIEent s waring.

«The foboweng projecter seltings il be set b sdvnce.

Pcture Dynanic s | Dynamic Contrast =0

a1 -0

Srighiness Convrol -oFF

Srighmess Control Gan - 100%

Light Output = Max Light Output Level
Wikt Balance Figh [Red, Green, Bus] =155

« Before st b sut adpstment, please confrm the folowing vetings are adjusted for of projecters.
Prcure Mode L
Contrast Gamma
Bightrmss Wivte Gen
ok Srsten Dyt View

ok St to begin Color Matching adpstrent.

O] | o

Setting initialization confirmation screen (color and brightness adjustment)

® A progress bar appears, and Auto Screen Adjustment for color and brightness adjustment starts.

B Auto Screen Adjustvent *

Projector Layout Camera Scttng

Please mast whie the outo adustment s 1 progress.
Do not nterfere with shooing wihie camera is working.
It may take several minstes

2% i:n mrxi‘ 171 3ec dapacd,

@ To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

N
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Auto Screen Adjustment Auto Screen Adjustment procedure

2 A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].

® To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking
[Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.
You can check each color on the screen.

Select Color | OFF ~

After Adjustment Before Adjustment

® The following message appears if Auto Screen Adjustment could not be completed and must be performed again.
To perform Auto Screen Adjustment for color and brightness correction again, click [Continue]. To exit Auto Screen
Adjustment, click [Finish].

Auto Screen Adjustment

The following adjustment could not yet complete in this condition.
l 3 Red,Green,Blue,Cyan, Yellow, White ®
i

‘fou can check each color on the screen.
Select Color | White v_—@
Do you want to continue to get better results?

Continue Finish

(D Colors for which Auto Screen Adjustment was not completed are displayed here.
@ Here you can confirm the adjustment results for the selected color on screen.

® A message appears if Auto Screen Adjustment fails due to overexposure.

If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.

® If Auto Screen Adjustment for color and brightness adjustment is performed again and fails to complete, a message will
appear. Click [OK] to exit Auto Screen Adjustment.

In such cases, perform adjustment manually in the main screen of “Geometry Manager Pro”.
& “Adjustment and Settings — Color Matching” (page 67)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment >

Do you want to exit aute adjustment?

o [Ee]

® The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time
you configure the settings.
® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.
&= “Adjustment and Settings — Brightness Control” (page 64)
&= “Adjustment and Settings — Color Matching” (page 67)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® White Balance Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Next].

When you click [Next], the projector settings will change to those displayed on this screen.
® To return to the previous screen, click [Back].

B Auto Screen Adjustment

NOTICE: White Balarice adpsstmert vl begin soon.
D not aperate the prajactors oBher Inan Bis appicatien whie the suto SdNstment s wariing.

-~ The folovers progector settregs wil be set b advare.
You can change these settngs after auta adsiment frished,

Petire Gamma =22

Dynamic Iris | Dynamic Contrast o

AL =OFF

erighmes Control -0FF

Brightness Control Gan = 100%

Lght Qutpt = Max Light Oulput Level

ore st b oty edstment, please confrm the folowing settngs are adpsted for ol projectors.
Prcure Mode L

Contrast vihee Gan
Bighiness System Dayight Veew
Cokr

“1F the irpuat el charged after auto adpustment, White Batance selting »il be deared.

ik et 10 continue.

O] | o

Setting initialization confirmation screen
(White Balance Adjustments)

1)  When adjusting color, use the [Auto] option to optimize adjustment for the screen overall, or the [Target Setting] option
when configuring a target (standard) projector.

B Auto Screen Adjustment x
jector Layout Camera S Projectin Scing
Select the White Balarce setirg mode.
@ata
OTagetseting (= Torget settng mode cormot be seiected when staching)
Chek Start to begn White Ealance adustment.
o st
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2) If you select the [Target Setting] option, also select the projector that is to be the target.
® \When you click the target projector number, the number and its frame change to red.
® Click the [Restore] button to restore the last previously set configuration.
@ Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.

B Auto Screen Adjustment *

Select the White Balance setting mode.

@Torgetsetig (" Torget seting mode cannol be selecied when stocking.}

[l Ao to decrease brightness of target projectar by changing White Bakance vakie,

@ik the location of Larget projector on e layout chart below, (Terget s shavn in red.)

(Chck Start to begn White Balance adwstment.

® White balance is adjusted by configuring the [Picture]-[Color Temperature]-[USER1]-[White Balance High] values.

® In order to manually pre-configure white balance for the target projector, change the [White Balance High] settings as
described earlier.

® The results of white balance adjustment are saved to the projector for each input signal. When the input signal is
changed, do the adjustment again.

® \With some projectors that use single-chip DLP, the color matching setting is forcibly set to OFF when white balance is
adjusted. Refer to the operating instructions of the projector.

2 Click [Start].

The projector positioning information is saved.
A progress bar appears, and Auto Screen Adjustment for white balance starts.

B Auto Screen Adjustvent *

10% [1/1] processing. 2 sec clapsed.

® To cancel Auto Screen Adjustment, click [Abort].
Click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

N

109



Auto Screen Adjustment Auto Screen Adjustment procedure

3 A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].

® To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking
[Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.
You can check each color on the screen.

Select Color |OFF ~

After Adjustment Before Adjustment

® The following message appears if Auto Screen Adjustment could not be completed and must be performed again. To
perform Auto Screen Adjustment for white balance again, click [Continue]. To exit Auto Screen Adjustment, click [Finish].

Auto Screen Adjustment

The following adjustment could not yet complete in this condition.
8 White
You can chedk each color on the screen,

Select Color | White v——®

Do you want to continue to get better results?

(D Here you can confirm the adjustment results for the selected color on screen.

® A message appears if Auto Screen Adjustment fails due to overexposure.

If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.

@ If Auto Screen Adjustment of white balance is not completed a second time, a message is displayed. Click [OK] to
complete Auto Screen Adjustment.

In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.
@& “Adjustment and Settings - Picture” (page 79)

® When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment x
Do you want to exit aute adjustment?

o [EE]

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.

& “Adjustment and Settings - Input Signal Adjustments” (page 74)
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Auto Screen Adjustment

Auto Screen Adjustment procedure

Hm Black Level Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Start].

When you click [Start], the projector settings will change to those displayed on this screen.

® To return to the previous screen, click [Back].

B AutoScreen Adjustent

NOTICE: Block leved acipastment vl begin s,

Do nat aperate h

~The fobomerng projecter seltigs wil be set 1 sdvance.

Dy s | Dyamic Cantrast
M Projector Sync. Mode

recured whie the aut

rorking. Do nat changs the brightness.of the suroundings.

sk Mt 1o contrue,

Setting initialization confirmation screen
(black level adjustment)

Hest

® A progress bar appears, and Auto Screen Adjustment for black level adjustment starts.
B Auto Screen Adjustment x
D8 e i o e e 5
i:nj processing. 0 sex clapsed.
I abort

® To cancel Auto Screen Adjustment, click [Abort].
Click [OK] when the following screen appears.

Autc Screen Adjustment

Do you want to interrupt auto adjustment?

QK

. Cancel

2 A message indicating that Auto Screen Adjustment is complete appears.
Click [OK].

If [Geometry, Edge Blending] or [Black Level] was selected in “Starting Auto Screen Adjustment and selecting the

adjustment item” (page 91), Auto Screen Adjustment is complete.

If [Geometry, Edge Blending, Color Matching] was selected at “Starting Auto Screen Adjustment and selecting the
adjustment item” (page 91), go on to the procedure for “m Color Matching Adjustments” (page 105)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking
[Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.
You can check each color on the screen.

Select Color | OFF o

After Adjustment Before Adjustment

® The following message appears if Auto Screen Adjustment could not be completed and must be performed again.

To perform Auto Screen Adjustment for black level correction again, click [Continue]. To exit Auto Screen Adjustment for
black level correction, click [Finish].

Auto Screen Adjustment

The following adjustment could not yet complete in this condition.
! 1 Black
N

You can chedk each color on the screen.
Select Color | White “

Do you want to continue to get better results?

® A message appears if Auto Screen Adjustment fails due to the impact of external lighting, etc.
An error occurs if the surroundings are too bright or the brightness is changed. In such cases, click [OK] and configure
settings again.

® If Auto Screen Adjustment for black level correction is performed again and fails to complete, a message will appear.
Click [OK] to exit Auto Screen Adjustment for black level correction.

In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.
& “Adjustment and Settings - Edge Blending” (page 55)

® When you click the x button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment >

Do you want to exit aute adjustment?

o [(EE]

® The projector layout information configured during Auto Screen Adjustment is stored until the next time you configure the
settings.

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.

&= “Adjustment and Settings - Edge Blending” (page 55)
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Frequently Asked Questions

Check the following points once more before requesting repair.

Projector is not recognized.

® Has the projector’s power been turned on?

@ |Is the projector supported by the software application? &= “Projectors supported” (page 10)
® Have the units been connected properly? &= “Preparation” (page 10)

® Has the projector’s network been set up correctly? &= “Setting the Projector” (page 11)

® Has an attempt been made to connect 100 or more projectors?

No connection can be made between my projector and my computer

® \When Windows Firewall has been detected

Windows 7

Is this software registered in [Start] — [Control Panel] — [System and Security] — [Windows Firewall] —[Allowed

programs and features] tab?

To register the software, perform the following.

® How to set up

1. Click [Start] — [Control Panel].

2. When the <Control Panel> appears, click [System and Security] — [Allow a program through Windows Firewall].

3. When <Allow programs to communicate through Windows Firewall> appears, click [Change settings] — [Allow
another program...].

4. When the <Add a Program> dialog box appears, select [Geometry Manager Pro] and click [Add].
If [Geometry Manager Pro] is not on the list, click [Browse], select [GeometryGUIl.exe] and click [Open]. [Geometry
Manager Pro] appears in the [Program] column

5. [Geometry Manager Pro] appears in the [Allowed programs and features] column.

6. Select the network from [Home/Work (Private)], [Public] you want to allow connection to and click to select the check
box.

7. Click [OK] in the <Allow programs to communicate through Windows Firewall].

8. This software will now be added to the Windows firewall's exception list.

Windows 8.1 / Windows 10

Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel] — [System and Security]

— [Windows Firewall] — [Allow an app or feature through Windows Firewall] to see if this program is on the list.

Add the software to [Allow an app or feature through Windows Firewall].

® Adding procedure

1. Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].

2. When the <Control Panel> appears, click [System and Security] — [Allow an app through Windows Firewall].

3. When <Allow apps to communicate through Windows Firewall> appears, click [Change settings] — [Allow another
app...].

4. When the <Add an app> dialog box appears, select [Geometry Manager Pro] and click [Add].

If [Geometry Manager Pro] is not on the list, click [Browse...], select [GeometryGUIl.exe] and click [Open]. [Geometry

Manager Pro] appears in the [App] column

[Geometry Manager Pro] appears in the [Allowed apps and features] column.

Select the [Private] or [Public] network you want to allow connection to and click to select the check box.

Click [OK] in the <Allow apps to communicate through Windows Firewall>.

This software will now be added to the Windows firewall's exception list.

® N o o»

<When another firewall has been detected>

Are any firewall-containing applications installed?

If any applications which contain firewalls are installed, the installation may not complete.

(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.

See the User’s Manuals for all applications containing firewalls to perform these settings.
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Messages that appear when an attempt to uninstall or update the software is made

<ls the "Warning 1910. Could not remove ..." message displayed?>
If an NVIDIA driver is installed on the computer, the following message may appear.

Geometry Manager Pro Ver.1.1.11.0 H

I Warning 191 0Could not remowe Shortcut Geometry Manager
b Frolnk. Werify that the shortzut file exists and that you can
access it.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start
up the computer next time. Manually delete the shortcut icons.

Files cannot be saved.

® Has an attempt been made to save a file that includes values that exceed the range which can be set in the projector?
® |s there enough free memory on the hard disk?
® Do you have the authority to access the folder in which the file is to be saved?

Image correction cannot be performed.

® Have settings been sent to the projector that exceed the range which can be set in the projector?

® Has the projector’s power been turned on?
Some items cannot be set if the projector’s power is not on.

® Are the projector’s input connectors set correctly, and have the correct signals been input?
Some items cannot be set depending on the input connector settings, the types of signals input and whether or not
signals are present.

The bitmap used for masking purposes cannot be loaded.

® Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?

® Does the bitmap have the appropriate size?
Bitmaps smaller than 8 x 8 pixels and bitmaps larger than 1920 x 1200 pixels (when the resolution of the projector is
1920 x 1200 dots or 1400 x 1050 dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned)
cannot be used for masking.

Cannot connect to the camera (Auto Screen Adjustment).

® [s the camera turned on?
® |s the camera connected to the computer properly?
® |s there a large number of data files stored on the SD card inserted in the camera?
If camera connection fails, try removing the SD card and performing the camera connection settings again.

Auto Screen Adjustment does not start.

® You may not be able to execute Auto Screen Adjustment depending on the projector's settings. For details on
operations restricted by the projector's settings, check the information found on the software download page after
logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

The image does not fit exactly on flat screens (Auto Screen Adjustment).

® The projected image may not match the edges of the screen exactly if the screen is sagging.
If the top and bottom edges are off:
In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the
shape of the screen.
If the left and right edges are off:
In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the
shape of the screen.
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Geometry correction results in an images that appears curved (Auto Screen Adjustment).

® This occurs on soft curved screens and on screens with heavy sag.
Correction is performed so that the image appears straight from the point of view of the camera.
Position to the camera so that it is as close as possible to directly facing the screen.

An exposure adjustment error occurs on the camera (Auto Screen Adjustment).

® If the projector is too bright or the screen's gain is high, for example, an exposure adjustment error may occur during

camera settings configuration.
In such cases, attach an ND filter to the camera lens, or lower the brightness of the projector before performing

adjustment again.
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Trademarks

® Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.

® Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the
respective companies. Note that ® and TM marks are not indicated in the text of this manual.

® Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
@ Panasonic cannot be held liable for any effects resulting from the use of this software and manuals.
® Panasonic reserves the right to revise this software specifications and manual contents without notice.

Panasonic Corporation

Web Site : https://panasonic.net/cns/projector/
© Panasonic Corporation 2017
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